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Chapter 1 
Software Introduction 
 This chapter contains:  
 - Software overview 
 - Technical parameters 
 - Installation and uninstallation 
 - About 
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Software Introduction 

1.1 Software Overview 

This software is Sat-LiDAR point cloud pre-processing and post-processing software, mainly for 

SatLab LiDAR solution, the function is to utilize the POS data solved by the combined navigation module 

of the mobile measurement system to convert the scanned point coordinates based on the equipment 

coordinate system in the original scanning file of the three-dimensional laser scanner to the geodetic 

coordinate system, and the output results include: the target point cloud file (Output formats include 

hlz, las, and xyz). 

Sat-LiDAR software supports the accuracy verification function of point cloud data for users. 

The software also provides comprehensive data quality checking functions: including original data 

checking, route quality checking, air strip overlap analysis, height difference quality checking, density 

checking, range checking, and support for exporting pdf format quality checking report. 

At the same time, the software also supports point cloud tiling, point cloud classification, DEM 

generation, contour line generation, elevation point generation and other functions. 
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1.2 Technical Parameters  

Operating system Microsoft Windows10 (64-bit) 

Microsoft Windows11 (64-bit) 
CPU Intel@Core i7 or above; 6-core processor 
Memory Not less than 16GB 
Graphics Card recommended NVIDIA discrete graphics card, 

video memory not less than 2GB 
Monitor resolution 1920*1080 and above 

NET Environment NET Framework Version 3.5 
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1.3 Installation and Uninstallation 

1.3.1 Software Installation 

1. Click on the Sat-LiDAR software installation package to bring up the installation screen shown 

below. 

 
Figure 1-1 Software Installation Interface 

2. Click Next, set the installation path (usually keep the default) 

3. Click Next to install the software. 

4. Click Finish to complete the software installation. 

 
Figure 1-2 Successful Software Installation Interface 

5. The program is successfully installed and the Sat-LiDAR program icon appears on the desktop. 
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           Figure 1-3 Sat-LiDAR icon 

Note: Turn off your firewall and antivirus software during installation to prevent the installation 

process from being interrupted by antivirus software; 

1.3.2 Uninstalling the software 

Method 1: Click the computer start menu, find Sat-LiDAR, click "Uninstall Sat-LiDAR", a dialog box 

will pop up whether to uninstall or not, click Next --- Finish to uninstall. 

Method 2: Go to Control Panel -> Programs and Features, right-click to uninstall it. 

1.3.3 Software Startup 

After the software is installed, if the software is not authorized, the dialog box shown below will 

pop up when the software starts. After closing the dialog box, the software will exit automatically. 

1. Software Dongle 

2. License file 

Copy the serial number from the Register ID then get license file from SatLab technical team. 

 
Figure 1-4 Software License Register 
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Chapter 2 

Sat-LiDAR quick instruction 

 This chapter contains:  
 - Software interface 
 - Simple workflow  
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Sat-LiDAR Quick Instruction  

2.1 Software Interface 

2.1.1 Welcome Interface 

After starting the software, a welcome interface will pop up, which mainly introduces the new 

features and main functions of this version of the software. 

  
Figure 2-1 Welcome Interface 

2.1.2 Main Interface 

The Sat-LiDAR software mainly consists of a menu bar, toolbar, workspace, normal toolbar, data 

view, log output and view control area. 

 
Figure 2-2  Sat-LiDAR Main Interface 
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2.1.3 Interface elements 

Sat-LiDAR software is mainly divided into twelve menu modules:  

<File>, <Aircraft>, <SLAM>, <Process>, <Terrain>, <Architectural>,<Draw>, <View>, <Tools>, 

<Engineering Applications>, <Layout> and <Help>. 

 

 
Figure 2-3 Sat-LiDAR Menu bar 

2.1.3.1 File 

The <File> menu mainly consists of the following options: 

⚫ New Project 

⚫ Open Project 

⚫ Save Project 

⚫ Close Project 

⚫ Open Files 

⚫ Open Work Area 

⚫ Save Work Area 

⚫ Save Work Area As 

⚫ Close Work Area 

⚫ Check the update 

⚫ System Setting 

⚫ About 

⚫ Exit 

⚫ List of the most recently opened files 

 
Figure 2-4  Sat-LiDAR File menu 
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2.1.3.2 View 

The <View> menu controls the main view browsing display, including browsing and rendering 

options. 

1. Browsing Functions: 

⚫ Panoramic browsing 

⚫ Flying browsing 

⚫ Setting the center of rotation 

⚫ Sync to view 

⚫ Roll-up 

⚫ Track Roaming 

⚫ View linkage 

⚫ View screenshots 

⚫ Setting the view to show all 

⚫ Full screen display 

⚫ Top view 

⚫ Bottom view 

⚫ Left view 

⚫ Right view 

⚫ Front view 

⚫ Back view 

⚫ 2D view 

⚫ 3D view 

2. Rendering Functions: 

⚫ Set different rendering methods for the point cloud 

⚫ Adjust transparency display 

⚫ Adjust point size 

3. Rendering Methods: 

⚫ Elevation rendering 

⚫ Strength rendering 

⚫ Monochromatic rendering 

⚫ Category rendering 

⚫ Airbelt rendering 

⚫ Echo rendering 

⚫ RGB rendering 

⚫ RGB rendering 
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⚫ Circulating elevation rendering 

⚫ EDL rendering 

⚫ Mixed rendering 

 
Figure 2-5 Sat-LiDAR View menu 

2.1.3.3 Aircraft 

 
Figure 2-6 Sat-LiDAR Aircraft menu 

1. Data Combine: 

⚫ Combine setting and data combining for selected POS projects or point cloud files 

⚫ Start/stop combining for selected point clouds through the Start Combine/Stop 

Combine menu item 

2. Trajectory Rectify: 

⚫ One-click strip adjustment 

3. Point Cloud Smoothing: 

⚫ Optimize point cloud 

4. Point Cloud Coloring: 

⚫ Perform coloring operations on the selected point cloud 

5. Accuracy Inspection: 

⚫ Verify the data absolute accuracy via imported control points. 

6. Quality Check: 

⚫ Data integrity check 

⚫ Route quality check 

⚫ Strip overlap check 

⚫ Height difference quality check 

⚫ Density check 

⚫ Coverage Quality check 

⚫ Automatic quality checks 

2.1.3.4 Tool 

The <Tool> menu includes point cloud measurement, point cloud cutting and export, query, and 

format conversion. 
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1. Point Cloud Measurement: 

⚫ Measure 3D distance 

⚫ Measure 2D distance 

⚫ Measure density 

⚫ Measure slope 

⚫ Measure angle 

⚫ Measure height 

⚫ Measure area 

⚫ Measure volume 

⚫ Measure surface area 

2. Point Cloud Selection: 

⚫ Circle selection 

⚫ Rectangle selection 

⚫ Square selection 

⚫ Polygon selection 

3. Point Cloud Cutting and Export: 

⚫ Cut Unselected Points 

⚫ Cut Selected Points 

⚫ Revoke Cutting 

⚫ Export Cutting 

4. Cross section  

5. Query  

⚫ Single-point query 

⚫ multi-point query 

⚫ POS point query 

⚫ measurement point annotation operation 

6. Point Cloud Format Conversion: 

⚫ Convert point cloud format and version number according to user needs 

 
Figure 2-7 Sat-LiDAR Tool menu 

2.1.3.5 Process 

The <Process> menu includes point cloud split, point cloud registration and point cloud 

classification functions. 
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1. Point Cloud  Split: 

⚫ Split point clouds by customized block size. 

⚫ Split by the customized number of blocks. 

⚫ Split according to the scale of the plot. 

⚫ Split according to vector formatting. 

⚫ Choose output format and version as needed. 

2. Point Cloud Registration: 

⚫ Manual Registration. 

⚫ Sketch Stitching. 

3. Point Cloud Classification: 

⚫ Reset classification. 

⚫ Noise filtering. 

⚫ Ground point classification.  

⚫ Middle ground point classification. 

⚫ Save and manage classification templates. 

 
Figure 2-8 Sat-LiDAR Process menu 

2.1.3.6 Terrain 

The <Terrain> menu includes the following functions: 

1. Generate DEM (Digital Elevation Model): 

⚫ Generate .tif and .img format DEMs for engineering LAS point clouds by grid size. 

2. Generate DSM (Digital Surface Model): 

⚫ Generate .tif and .img format DSMs for engineering LAS point clouds by grid size. 

3. Generate Contour Lines: 

⚫ Generate contour lines in .dat, .txt, and .xyz formats for project LAS point clouds by 

grid size. 

4. Generate Elevation Points: 

⚫ Generate elevation points in .dat, .txt, and .xyz formats for engineering LAS point clouds 

by grid size. 

5. Generate Power Point 

⚫ Support the generation of engineering HLZ and LAS point cloud according to the DEM  

    sampling interval and section height difference. Power point file in the org format. 
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6. Earthwork Calculation: 

⚫ Generate single-phase or multi-phase fill and excavation data for project LAS point clouds 

by grid size. 

 
Figure 2-9 Sat-LiDAR Terrain menu 

2.1.3.7 Layout 

The <Layout> menu is used to control the showing/hiding of the panels, views and elements in the 

views. The panels included in the software are:  

⚫ Layer Management 

⚫ Properties Panel 

⚫ Toolbox 

⚫ Information Output (Console) 

⚫ Show/Hide of Welcome Screen 

 
Figure 2-10 Sat-LiDAR Layout menu 

2.1.3.8 Engineering Applications 

⚫ Generates reference horizontal section 

⚫ Generate vertical section 

⚫ Generate horizontal section 

⚫ Measured longitudinal section 

⚫ Edit the sections 

⚫ Export the sections 
⚫ Generate section view 

⚫ Support the section method for earthwork calculation 

⚫ Support for multi-period section comparison 
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Figure 2-11 Sat-LiDAR Engineering menu 

2.1.3.9 Draw 

Single used to add all kinds of points, lines, and surface entities: 
⚫ Delete the entity 

⚫ Line interrupt 

⚫ Two points interrupt 

⚫ Connect 

⚫ Copy 

⚫ Extend 

⚫ Smooth 

⚫ Select layers and encoding properties 

⚫ View properties 

 
Figure 2-12 Sat-LiDAR Draw menu 

2.1.3.10 Common toolbar 

To facilitate user operations, commonly used tools are placed in the frequently used toolbar. By 

default, the toolbar is in a docked state.  

⚫ Float: Click the <Float> button to adjust the toolbar to a floating state. 

⚫ Restore: Close the floating window to restore the toolbar to the docked state. 
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Figure 2-13 Common Toolbar in Docked State 

 
Figure 2-14 Common toolbars in the floating state 

 

Table 2-1 List of Common Toolbar Functions 

  Bottom view 

 Front view 

 Back view 

 Left view 

 3D view 

 2D view 

 Full screen 

 EDL rendering 

 
Turn on the elevation + intensity 

mixed rendering 

 Display Transparency 

 Intensity strength 

 Measure 3D distance 
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 Measure 2D distance 

 Section view 

2.1.3.11 Workspace 

The workspace catalog is categorized according to layers, including: 

⚫ Point cloud 

⚫ Raster 

⚫ Vector 

⚫ Control point 

⚫ Model 

⚫ POS trajectory 

⚫ Annotation layers 

When loading data, it will be linked to the corresponding layer based on the data type. For example, 

loaded LAS data will be linked to the point cloud layer. 

 
Figure 2 -15 Workspace 

2.1.3.12 Data View 

The data view is the main area of the software. It includes: 

⚫ Multi view 

⚫ Profile view 

⚫ 2D view 
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Figure 2-16 Multi-view and sectional view 

 
Figure 2-17 Multi-view control bar 

The title bar of each multi-view window consists of view basic attribute information and common 

tools. 

1. Attribute Information: 

⚫ View name (e.g., view 1) 

⚫ View angle (e.g., top view) 

⚫ 2D and 3D display (e.g., 3D view) 

⚫ View rendering method (e.g., elevation rendering) 

2. Common Tools: 

Refer to Table 2-2 for a detailed list of commonly used tools. 

 
Figure 2-18 Multi-View Window Title Bar 
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Table 2-2 List of Tool Functions in Multi-View Title Bar 

 Top view 

 Right view 

 Zoom Full View 

 Elevation Rendering 

 Intensity Rendering 

 Monochrome Rendering 

 Classification Rendering 

 Zonal Rendering 

 Echo Rendering 

 RGB Rendering 

 Classify Render Settings 

3. Attribute Panel: 

Point cloud data information including: 

⚫ File location 

⚫ Number of points 

⚫ Enclosing box size 

⚫ Maximum and minimum value points 

⚫ Transform parameters 

⚫ Format version 

⚫ Generation time 
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Figure 2 -19 Attribute Panel - Point Cloud Data 

For raster data, including: 

⚫ File location 

⚫ Wavelength 

⚫ Base elevation 

⚫ Elevation range 

⚫ Pixel size 

 
Figure 2-20 Attribute Panel - Raster Data 

2.1.3.13 Toolbox 

The toolbox includes some common tools, mainly including point cloud format conversion, point 

cloud to image, extraction, point cloud amplitude, data processing and other functions. 
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Figure 2-21 Toolbox 

2.1.3.14 Information Output 

The message output is used to display information about key steps in the data processing process, 

error messages and warning messages. 

 
Figure 2-22 Console Output Panel 

2.1.3.15 Status Bar 

The main purpose of the status bar is to display alert messages, such as the progress of task 

execution. The process can be canceled at any time by clicking the <Cancel> button. 

 
Figure 2-23 Progress Bar 

2.2 Standard Operation Procedure 

The following is a standard workflow for data process. For more detailed instructions, please refer 

to each chapter of the manual. This procedure is a solution we provide to the user. Once you become 

proficient with the software, you do not need to strictly follow this procedure. The usual process involves: 

⚫ Preparation: Ensure that all necessary data and files are ready and accessible. 

⚫ Project Setup: Create and configure a new project according to your needs. 

⚫ Data Import: Import the required data such as point clouds, raster images, or vector files into 

the workspace. 

⚫ Data Processing: Use the tools and functions available in the software to process the data, such 

as point cloud combining, classification, and rendering. 

⚫ Analysis: Perform analysis and quality checks on the processed data, including integrity checks, 
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accuracy checks, and elevation quality checks. 

⚫ Visualization: Adjust the view settings and rendering methods to visualize the data effectively. 

⚫ Export: Export the processed data and results in the desired formats and configurations. 

2.2.1 New project 

Creat new project <File> -> <New project>, input projecet name and select project folder.  

 
Figure 2-24 New Project 

2.2.2 Original data Check  

Click <Original data Check> under the <Quality Check> menu on the main interface. The original 

data quality check contains four items: 

⚫ Data integrity check 

⚫ Scanning data check 

⚫ Image data check 

⚫ POS data check 

Abnormal items will be listed in the notes and reports for reference. 

 
Figure 2-25 Original data Quality Check 

2.2.3 Strip edit 

Its main functions include  
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1. Drawing the POS cutting area 
2. Cutting the POS track 
3. Adding / deleting the cutting navigation belt 
4. Cutting the POS track. 

 
  Figure 2-26 Airbelt Edit Panel 

2.2.4 Flight route inspection 

1. Click <Quality Inspection> menu under <Route Quality Inspection>. 

2. Set the parameters according to the project requirements: 

⚫ Design height 

⚫ Design speed 

3. Click Quality Inspection after completing the setup. 
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Figure 2-27 Flight Route Quality Check 

 

2.2.5 Project and point cloud combine setting 

1. Combine project setting 

The setup parameters are applied to the entire POS project. In this dialog box, users can: 

⚫ Check the format and version of the output point cloud. 

⚫ Set the coordinate conversion parameters. 

⚫ Denoise (select according to the scene whether has power line or not) 

⚫ Point cloud optimization 

 
Figure 2-28 Project Combine Settings 
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2. Point cloud combine setting 

Select the FOV of LiDAR and advance setting of filtering parameter. 

 
Figure 2-29 Point Cloud Combine Settings 

2.2.6 Data combine and optimization 

1. Begin combine  

2. Trajectory rectify 

⚫ One click auto strip adjustment processing to refine data. 

3. Point cloud smoothing 

⚫ Set parameter to smooth point cloud. 

2.2.7 Point cloud quality check 

After you get the point cloud, the quality check of the point cloud can be carried out if necessary.  

2.2.7.1 Strip overlap check 

1. The project management panel opens the fusion project and loads the navigation band 

2. Click the "navigation band overlap check" under the menu on the main interface 

3. The system will automatically recommend the grid size and overlap rate threshold parameters 

according to the data, and the user can set the parameters according to the project requirements 

4. Click to start checking after the setting is complete 
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Figure 2-30 Overlap Inspection 

2.2.7.2 Height difference Quality Check 

1. The Engineering management panel opens on the fusion project 

2. Load the display point cloud file 

3. Click the menu on the main interface, and the "high difference quality check" dialog box pop 

up. By default, the size of the grid is 2 meters, and the critical threshold is 0.5 meters. Fill in the location 

of the test area, weather conditions and inspectors 

4. Click the button [quality check and export], the program will check the high difference quality 

and export the report 

 
Figure 2-31 Height Difference Quality check 

2.2.7.3 Density Quality Check: 

1. The project management panel opens the fusion project and loads the display point cloud file 
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2. Click "Density Quality Check" under the "Quality Inspection> menu on the main interface, and 

the" Density Quality Check " dialog box pop up. By default, the size of the grid is 2 meters, and the 

average density threshold is 10 points / square meter. Point cloud files can be added and removed 

according to the project requirements 

3. Click the quality check and export, the program will check the density quality and export the 

corresponding report 

 
Figure 2-32 Density Quality Check 

 

2.2.7.4 Coverage inspection 

1.Open Project 

In the Project Management panel, open the fusion project and load the point cloud. 

2.Start Coverage Check 

Click Aircraft> Quality Check > Coverage Check on the main menu. The Coverage Check window will 

appear. 

3.Set Parameters 

Choose a grid size (e.g., 1m x 1m). Import the boundary file (.shp, .dxf, or .dwg) that outlines the survey 

area. 

4. (Optional) Add Info, You can fill in optional fields: 

Survey location, Weather conditions, Inspector name, Run and Export 

5.Click Run Check and Export. 

The software will check the coverage and create a PDF report. After it's done, the folder with the report 

will open automatically. 
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Figure 2-33 Completion rate inspection 

2.2.8 Section view check stratification 

1. On the main interface, click the menu <Tool> ->Vertical section 

 

Figure 2-34 Section view 

2.2.9 Trajectory Rectify 

This process refines the trajectory (POS data) to improve the consistency and overlap of point cloud 

data across sorties. 

1. Open Aircraft Project 

Launch the Project Management Panel, open the relevant fusion project, and load the display point 
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cloud files. 

2.Access Trajectory Rectification Tool 

Go to the main menu and select Aircraft > Trajectory Rectify. The Trajectory Rectify dialog box will 

appear. 

3.Select Sorties and Input Files 

Check the sorties that require correction. For each sortie, specify the corresponding POS file and raw 

point cloud file. 

4. Import Ground Control Points (Optional) 

If target control points are available, import them. Enable Automatic Target Matching to automatically 

detect and match control targets in the scene. 

5. Define Checkpoints (Optional) 

In the Control Point List, right-click any point to mark it as a Checkpoint, which will be excluded 

from the rectification calculation but used for accuracy assessment. 

6. Execute Rectification 

Click OK to start the trajectory correction process. 

7. Review Outputs 

Once rectification is completed, the adjusted point cloud is auto-loaded in the viewer. A detailed 

Trajectory Rectification Report is generated in the point cloud output directory. The report includes: 

Overview of rectified point cloud quality 

Minimum error, maximum error, and RMS (Root Mean Square) deviation 

If XYZ control points are used, the report additionally includes: 

Ground control coordinates and scan point coordinates (before and after rectification) 

 

Figure 2-35 Trajectroy Rectify Interface 
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Figure 2-36 Automatically identify targets 

2.2.10 Precision check 

On the premise that the point cloud has been loaded and the point cloud control points are 

associated, enter the fast accuracy verification dialog box. Precision check provides two ways of manual 

point selection and automatic search for point selection. 

1. Manually select points: 

By selecting the scanning point to check with the control point, the precision check is obtained. 

Click fast accuracy verification, the page will call up the magnifying glass view for use. In each control 

point corresponding to match the scanning point, left click to confirm the selection point, scanning 

point, after success, control points in the list of the right point will fill the corresponding scanning point, 

if not satisfied with the point, can be relocated to the corresponding scanning point position, select the 

scanning point, or can manually modify the scanning point coordinates, according to the return 

confirmation. At this time, the selection of all scanning points is completed, click the accuracy check, 

and the system will automatically calculate the accuracy results of the current data according to the 

corresponding relationship between the control point and the scanning point. 

2. Automatic search:  

when click automatic search, the program first find the targets near the control point, the current 

support size is 50cm * 50cm target square board, through the algorithm automatically identify the target 

center position automatically identify the target center scanning point, such as no target punctuation is 

automatic search function is generally only applicable to the elevation type of point. Click the automatic 

search, the program will automatically detect the coordinate position of the scanning point 
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corresponding to the control point. 

2.2.11 Point cloud coloring 

Two method to colorize: 

⚫   Single Image: Click <Point Cloud Coloring> through the menu bar, the default is the single 

image coloring TAB page, and the system will automatically load the point cloud path and output 

path. Check the color point cloud, click OK, will be checked the point cloud for single image color 

⚫   Ortho Image：Orthoactive coloring: click <Point Cloud Coloring> through the menu bar, 

default to the single image coloring TAB page, switch to the orthoactive coloring module, the system 

will automatically load the point cloud path and other data paths. If it is inconsistent with the 

requirements, it can be manually selected. Check the selected colored point cloud, select the image 

TIF file, and select the output path, and the checked point cloud will be positively colored. 

 
Figure 2-37 Single Image 

 
Figure 2-38 Ortho Image 
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2.2.12 Point Cloud Processing 

Click <Point Cloud Processing>  and the point cloud data will be loaded to the <Process> module. 

 
Figure 2-39 Point Cloud Processing 

2.2.12.1 Point Cloud tiling 

Split the point cloud according to specific criteria, generates tile vector and extracts each small 

piece of the point cloud for separate processing. This will speed up the processing efficiency.  

 
Figure 2-40 Point Cloud Tiling 
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2.2.12.2 Point cloud Classify 

1. Reset Classify 

Classify by class, the default is all classes classify to <1-Unclassify>. 

 
Figure 2-41 Reset Classify 

2. Noise Filter 

Classify noise points including SOR filter, Outlier filter and low points fiter. 

 
Figure 2-42 Noise Filter 

3. Classify Ground 

 
Figure 2-43 Ground point classification 
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4. Median point of the ground 

Ground Median Point is not checked by default. 

 
Figure 2-44 Classify Median Ground point 

5. Execute classification  

 
Figure 2-45 Median point of the ground 

6. Partical Classify 

Select specific area for ground point classification. 
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Figure 2-46 Partical Classify 

7. Manual Classify  

In the profile view, you can manually classify the points. Manual classification involves editing and 

modifying the categories to which the point cloud belongs. This includes: 

⚫ Classification above the folding Line: Classifying points above the drawn line. 

⚫ Classification under the folding Line: Classifying points below a drawn line. 

⚫ Classification between the folding Lines: Classifying points between two drawn lines. 

⚫ Classification of polygons: Classifying points within a defined polygonal area. 

⚫ Classification of brushes: Using a brush tool to classify points in a specific area. 

⚫ Classification of single Points: Classifying individual points manually. 

 
Figure 2-47 Manual Classify  
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2.2.10 Generate terrain products 

1. Generate DEM：This function is mainly used to generate the relevant DEM model files locally. 

⚫ On the main screen, click the menu <Terrain> <Generate DEM> 

⚫ The dialog box can select the point cloud data that needs to generate the DEM model file 

⚫ Set the ground category and grid size of the generated model, where the resolution size is 

divided into three types: 1:500,1:1000 and 1:2000, corresponding to different grid sizes 

⚫ Set the format of export files, mainly tif and img 

⚫ Since this function can batch DEM model files for multiple point clouds, it is necessary to click 

merge to generate, select the folder to save the batch files, and click [OK] to start generation 

 
Figure 2-48 Generate DEM 

2. Generate contour lines: This function is mainly used to generate relevant contour model files 

locally 

⚫ On the main screen, click menu <Terrain> <Build contour> 

⚫ In the dialog box, you can select the point cloud data required to generate contour model files, 

and select the terrain type that the point cloud data belongs to 

⚫ Set the ground point category, contour ratio and contour levels of the generated model, and 

the grid contour ratio is 1:500,1:1000 and 1:2000 respectively, corresponding to different contour 

levels 

⚫ Set the format of the export file, mainly in the dxf format. Since this function can batch generate 

contour model files for multiple point clouds, it is necessary to select the folder that saves the batch 

files 

⚫ Click [OK] to start the generation 
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   Figure 2-49 Generate contour lines 

3. Generate Elevation Points: This function is mainly used to generate the relevant elevation point 

information text file locally, mainly including the numbering, x coordinate, y coordinate and the 

corresponding elevation value 

⚫ On the main screen, click menu <Terrain> →<Generate elevation Point> 

⚫ The dialog box selects the point cloud data required to generate the elevation point file 

⚫ Set the ground category and the grid size of the generated elevation point. The resolution size 

of the grid is divided into three types: 1:500,1:1000 and 1:2000, corresponding to different grid 

sizes 

⚫ Set the format of the export files, mainly in three text file formats: dat (Southern Cass), txt (NXYZ) 

and xyz (NXYZ). Since this function can batch generate files on multiple point clouds, you finally 

need to select the folder that saves the batch files 

⚫ Click [OK] to start the generation 

 
Figure 2-50 Generate Elevation Points 
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Description of the main functions 

3.1 Files 

The project file (*.hdw) is a snapshot of the current workspace. When saved, it allows for quick 

reopening to recover the files associated with the current project data. Saving a project file only saves 

the file path and the data in the workspace, but not the point cloud and image data. 

File Menu Options: 

1. Open Data: Load new data into the workspace. 

2. Open Workspace: Open a previously saved workspace (*.hdw). 

3. Save Workspace: Save the current workspace state to a project file (*.hdw). 

4. Save Workspace As: Save the current workspace state to a new project file (*.hdw). 

5. Close Workspace: Close the current workspace. 

6. System Settings: Adjust system settings for the software. 

7. About: View information about the software. 

8. Exit: Close the software. 

9. Recent Files List: Access a list of recently opened files for quick reopening. 

3.1.1 New Project 

1. Open the New Project Menu: 

   - In the main interface, click <File> → <New Project>. 

2. Enter Project Name: 

   - In the "Project Name" field (see Figure 3-1), enter the name for the new fusion project. 

3. Select Data Catalog: 

   - Click the [Select] button next to the "Data Catalog" item. 

   - Choose the data directory that contains all the necessary data (typically a folder containing 

several iScan projects). 

4. Create the Project: 

   - Click the <OK> button. 

   - A new fusion project will be created, and the project information will be saved in the specified 

data directory. 
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Figure 3-1 New Project dialog box 

point out: 
1. The Project directory shall contain all the scan projects. This example contains the scan data of 

"HD099_20230814_9". The project directory shall select a single scan directory or multiple scan 
directory, and the project file "1. hdc" is stored under "Scan directory". 

2. The Project Catalogue should be the scanned project catalogue or its parent catalogue. This 
example fusion project contains only one scanning project, HD099_20230814_9 is both fusion project 
directory and scanning project directory, remember that "Data directory" should not be "below" <D: \ 
data \ S2 \ xingneng \ HI \ HD099_20230814_9> (must not select data directory as "001_Auto_01" 
level). 

 
Figure 3-2 Data Catalogue 

After the new project is completed, the program will automatically search for all qualified iScan 
projects in the selected directory, which is displayed in the tree list of the left file view. 

 
Figure 3-3 Schematic diagram of the fusion engineering structure 

⚫ The fusion project contains several POS projects, POS, which contains all the data collected by 

one section of POS 

⚫ POS, engineering contains several iScan, engineering, a POS file and a control point file (if 

required) 
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⚫ The iScan project contains several point cloud data (generally no more than 3 data data) 

⚫ There are icon identification types before each node, including folders, point clouds, files and 

other types 

⚫ Each node is preceded by checkbox for each node and can be checked for fusion processing 

⚫ Each node can be right-button pop up the corresponding menu, the corresponding processing 

Frequently asked questions: 

1. The prompt information in the following figure is popped up, indicating that the trajectory 

configuration file iScan-Route.config format is not correct. Therefore, we need to check the parameters 

of the file, whether there are any assigned parameters or wrong parameters. 

 
Figure 3-4 Error prompt box 

3.1.2 Open Project 

1. Open the Project Menu 

   - In the main interface, click <File> → <Open Project>. 

2. Select Project File 

   - A dialogue box (as shown in Figure 3-5) will pop up. 

   - Select the desired project file. 

3. Open the Project 

   - Click the <Open> button. 

   - Once the combine project file is opened, the Project Manager's tree list will automatically 

display all the data associated with the combine project. 

 
Figure 3-5 Open project dialog box 
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3.1.3 Close Project 

1. Close the Project 

   - In the main interface, click <File> → <Close Project> to close the current combine project. 

2. Clear Display Data 

   - After closing, the display data in each view will be cleared. 

3. Save Project Confirmation 

   - A dialog box (Figure 3-6) will pop up, prompting whether to save the project file. 

 
Figure 3-6 Close Project dialog box 

3.1.4 Save Project 

1. Save the Project 

   - When the combine project changes (e.g., modifying the combine parameters through the 

combine setting dialog box), click <File> → <Save Project> in the main interface. 

2. Confirm Save 

   - The current state of the combine project, including any changes made, will be saved. 

3.1.5 Open Files  

Opening Files 

1. Open the File Menu: 

   - Click <File> → <Open Files> in the main interface. 

2. Supported File Types: 

   - The supported data types are: hlz, las, laz, xyz, txt, dxf, shp, tif, img, cpt, pos, ply. 

3. Select and Open File: 

   - Select the file that needs to be opened. 

   - Double-click the file or click the <Open> button. 

4. Load File: 

   - The program will load the file under the corresponding layer node based on its format. 

   - If a view is selected when loading the file, it will be loaded in that view. 

   - If no view is selected, the system will automatically open a view and load the file. 
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Figure 3-7 Open Files 

3.1.6 Opening Workspace 

Click <Open Workspace> to load an existing processing project file (*.hdw). 

3.1.7 Save Workspace 

By clicking <Save Workspace>, the software saves all the data of the current operation to the 

workspace.  

3.1.8 Save Workspace As 

Click <Save Workspace As>, the software will save the current workspace to another workspace 

file.  

3.1.9 Close 

By clicking <Close>, the software will close the current workspace, including the view display. 

3.1.10 System Settings 

1. Shortcut 

- Defining keyboard shortcuts for common functions. 
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Figure 3-8 Shortcuts setting 

2. Cloud platform account 
In the case of networking, enter the user name and password, and click log in. After logging in to 

the cloud platform account, the user can check the cloud base station for the cloud base station 
calculation in the trajectory calculation interface. The cloud base station calculation supports the data 
of nearly three months for the calculation. 

3. View Setting 

The view settings are primarily for adjusting the main view interface elements and measurement 

tool properties. This is illustrated in Figure 3-10. 

(1) Main View Interface Elements: 

   - Background Color: Modify the background color of the main view. 

   - Display Controls: Control the display and hiding of: 

      - Grid 

      - Axes 

      - Legend 

      - Scale 

(2) Measurement Tool Attributes: 

   - Selection Colors: 

      - Modify the selection point color. 

      - Modify the selection line color. 
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   - Line Width: Set the line width of the measurement line. 

   - Measurement Colors: 

      - Modify the color of the measurement line. 

      - Modify the color of the measurement surface. 

(3) Object Capture Mode: 

   - Enable object capture mode for key points in the mapping tool. 

   - Automatically capture endpoints, intersection point, nearest point, and extension line in the 

plotted line. 

 
Figure 3-9 View Setting 

3.1.11 About 

Clicking the <About> button brings up a dialog box displaying the following information about the 

software: 

- Software name 

- Version number 
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- SDK version 

- Build date 

- Other necessary details 

This information helps users identify the specific version and build of the software they are using.  

 

Figure 3-10 About 

3.1.12 Exit 

Clicking the <Exit> button will close the software. 
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3.2 View 

The <View> menu controls the main view browsing display, including browsing, rendering, and 

other display functions.  

3.2.1 View Browsing 

1. Fly View 

Click the <View>→<Fly view> to browse the point cloud in the main 3D view. 

⚫ View Rotation: hold down the left mouse button and move the mouse to rotate the view.  

⚫ Zoom In/Out: Slide the mouse wheel to zoom in and out of the view. 

⚫ View Panning: Hold down the right mouse button and move the mouse to drag the view . 

The following tools are only available in fly view mode:  

<Zoom screen>, <Top View>, <Bottom View>, <Left View>, <Right View>, <Front View>, <Back 

View>. 

 
Figure 3-11 Fly View 

 2. Zoom Screen 

Cick the <View>→<Zoom screen>, or click the button   on the title bar of the view. 

 
Figure 3-12 Zoom Screen 
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 3. Full Screen 

Click the <View>→<Full Screen>, or the button  in the common toolbar, press the ESC key to 

exit the full-screen display. 

 4. Rotate Center 

Click the <View>→<Rotation Center>, select the location of the rotation center in the point cloud 

view. 

 5. 2D View 

Click the <View>→<2D View>, or the button  in the toolbar to lock the point cloud view in a 2D 

state. 

 6. 3D View 

Click the <View>→<3D View>, or the button  in the common toolbar. The point cloud view will 

be locked in 3D. 

 7. Zoom In 

Click the <View>→<Zoom In>, press the left mouse button and draw the rectangle, the view inside 

the rectangle will be enlarged. 

 8. Zoom Out 

Click the <View>→<Zoom Out>, press the left mouse button and draw a rectangle, the view will 

be zoomed out centered on the rectangle. 

 9. Top View 

Click the <View>→<Top View>, or click  the button   in the common toolbar.  

 10. Bottom View 

Click the <View>→<Bottom View>, or click the button  in the common toolbar, the point cloud 

will be displayed in bottom view. 

 11. Left View 

Click the <View>→<Left View> , or click  the button  in the toolbar, the point cloud will be 

displayed in the left view. 

 12. Right View 

Click the <View>→<Right View>, or click the button  in the title bar of the view window. The 

point cloud will be displayed in the right view. 

 13. Front View 

Click the <View>→<Front View> , or click the button  in the toolbar. The point cloud will be 

displayed in front view. 

 14. Back View 
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Click the <View>→<Back View>, or click the button  in the toolbar. The point cloud will be 

displayed in the back view. 

3.2.2 Rendering 

1. Height Rendering 

Click the <View> → <Height Rendering> or the button   in the title bar  to display on Elevation. 

By select the drop down menu to change the color band of this rendering mode. 

 
Figure 3-13 Height Rendering 

  
Figure 3-14 Elevation Rendering setting 

2. Intensity Rendering 

Click the <View>→<Intensity Rendering>, or the button  in the title bar of the view window, the 

point cloud will be displayed as a rendering of the intensity value. 

  
Figure 3-15 Intensity Rendering 

3. Single Color Rendering 

The menu <View>→<Single Color Rendering>  button on the main interface is divided into two 

parts: arrow and icon.  

(1) Click on the arrow part, the drop-down menu will pop up (Figure 3-16).  
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⚫ <Single Color Rendering Settings>: set the Single Color rendering color corresponding to 

each file loaded in the current software (Figure 3-17). 

⚫ <Apply>: update the rendering color. 

⚫ <Reset Color>: restore all the color settings to the default.  

(2) Click on the icon section, or the button  in the title bar of the view window to single color 

render the point cloud in the currently selected view according to the set color. 

 
Figure 3-16 Single Color Rendering 

 
 Figure 3-17 Single Color Rendering setting 

4. Classify Rendering 

The <View>→<Classify Rendering>  button on the main interface has two parts: an arrow and an 

icon.  

Clicking the arrow reveals a drop-down menu (Figure 3-18).  

(1) Selecting <Category Rendering Settings> opens a dialog box (Figure 3-19) with 25 point cloud 

categories to set colors and toggle rendering via checkboxes.  

(2) Click <OK> to apply the settings, instantly updating all relevant views. <Reset Color> restores 

default colors.  

(3) Clicking the icon or the button  in the view window's title bar renders the point cloud in the 

current view based on the selected category's colors. 

 
Figure 3-18 Classify Rendering 
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Figure 3-19 Classify Rendering setting 

5. Airstrips rendering 

Cick the menu <View>→<Airstrips Rendering>, or the button  in the title bar of the view window, 

the point cloud in the currently selected view will be displayed as rendered by the aerotape (Figure 3-

20). 

 
Figure 3-20 Airstrips Rendering 

6. Echo Rendering 

The <View>→<Echo Rendering>  button on the main interface consists of an arrow and an icon.  

(1) Clicking the arrow opens a drop-down menu (Figure 3-21).  



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  59  

(2) Selecting <Echo Colorstrips Setting> brings up a dialog box (Figure 3-22) where you can set 

colors for single, first, middle, and last echoes. 

(3) Click <OK> to apply the changes, which will immediately update the echo rendering color if 

the current view is using echo rendering.  

(4) Click the icon or the button  in the view window's title bar renders the point cloud in the 

current view according to the set echo colors. Each view in a multi-view setup uses its own 

echo rendering settings. 

 
Figure 3-21 Echo Rendering 

 
Figure 3-22 Echo Rendering setting 

7. RGB Rendering 

Click the menu <View>→<RGB Rendering>, or the button  in the title bar of the view window, 

the point cloud will be displayed as rendered in true color (Figure 3-23). 

 
Figure 3-23 RGB Rendering 
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8.Cyclic Height Rendering 

Cick the menu <View>→<Cyclic Height Rendering>, the point cloud will be displayed through the 

cyclic elevation to render (Figure 3-24). 

 
Figure 3-24 Cyclic Height Rendering 

9.EDL Rendering 

Click the menu <View>→<EDL Rendering>, or the button  in the common toolbar, the point 

cloud is rendered when the contour visualization enhancement (Figure 3-25). 

 
Figure 3-25 EDL Rendering Contour Enhancement 

10 Mixed rendering 

On the main screen, click the menu <View> Mixed Render, or the common toolbar  push-button, 
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conduct the elevation + intensity rendering when rendering the point clouds. 

3.2.3 Other 

1. Show Transparency 

Click the menu <View>→<Show Transparency>, or the button  in the toolbar, the current view 

will show the transparency of the point cloud (Figure 3-26).  

Cancel: click the menu <View>→<Show Transparency> again (Figure 3-27). 

 
Figure 3-26 Show transparency 

 
Figure 3-27 Cancel display transparency 

2. Point size 

Slide the menu <View>→<Point Size> slider on the main interface, the size of the point cloud in 

the main view changes with the movement of the slider (Figure 3-28). 
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⚫ The slider corresponds to the point cloud from left to right from small to large, such as shown 

in Figure 3-29 for the point cloud is the smallest, such as shown in Figure 3-30 for the point 

cloud is the largest. 

 
Figure 3-28 Point Size slider 

 
Figure 3-29 Point size set to minimum 

 
Figure 3-30 Point size set to maximum 

3. Synchronize to View 

Click the menu <View>→<Synchronize to View> to open the dialog box (Figure 3-31).  
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⚫ When multiple point clouds are loaded in the main view, select the view, rendering type, and 

point clouds to be synchronized in the dialog box, and then click Apply to synchronize.  

⚫ If the rendering method selected is Category Rendering, you can adjust category visibility. 

 

 

 
Figure 3-31 Synchronize to View 

4.Poling View 

Click the menu <View>→<Poling View> , hold down the Shift key, the left mouse button drag, 

draw a rectangular box, release the mouse on the drawing of the region obscured (Figure 3-32). 
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Figure 3-32 Poling View 

5.Track Roaming 

(1) Click the menu <View>→<3D Track Roaming> , pop-up roaming settings dialog box 

( Figure 3-33). 

 
Figure 3-33 3D Roaming Settings 

(2) Set the time and frame rate, choose whether to record the screen and the path to save the 

video, click <Draw Roaming Route>, and then click the left mouse button in the view to select 

the roaming path node (Figure 3-34). 
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Figure 3-34 Select roaming path 

(3) Click <Start Roaming>, it will display the roaming in full screen (Figure 3-35). 

 
Figure 3-35 3D roaming 

(4) At the end of the 3D roaming, the video is saved in the selected path. 

6. Synchronize to view 

(1) Click the menu <View>→<Synchronize to view > . 

(2) By checking the need to link the view, click <OK>. Checked view windows can be synchronized 

in the browsing process (Figure 3-36).  

(3) Cancel the synchronization: click <View Synchronization> again. 
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Figure 3-36 View synchronization settings 

 
Figure 3-37 View synchronization 

7. View Snipping 

(1) Click the menu <View>→<View Snipping> . 

(2) Press the left mouse button and move anywhere on the screen, draw a rectangular box,. 

(3) Click the <Save As> button to take a screenshot to save (Figure 3-38). 

 
Figure 3-38 View Snipp 
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3.3 Aircraft 

The <Aircraft> menu mainly contains Auto Process, Trajectory solving, Trajectory Rectify, Quality 

Check, Data combine, Point Cloud Colorize, Point cloud smooth, and Accuracy Inspection. 

3.3.1 Auto Process 

Automatic processing is a one-stop, fast and simple data processing function, which facilitates 

customers to quickly and conveniently output point cloud data results from the original data, one-click 

base station data import, trajectory solution, pos cutting, point cloud fusion, redundant photo removal, 

point cloud coloring, and terrain results export. 

Steps: 

(1) Copy the original data collected by the equipment to the computer. 

(2) Create a new combine project. 

(3) Click <Aircraft> → <Auto Process> to enter the automatic processing interface (Figure 3-39). 

 
Figure 3-39 Automatic processing dialog box 

1. Base Station Settings 

(1) Base station setting includes base station file selection, base station coordinate setting, choose 
base station information from favorites, save to favorites, output coordinate type, and 
eliminating redundant data. 

(2) Coordinate points can be saved to favorites, set the name of the base station, set the base 
station name and click <OK> (Figure 3-40). 
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Figure 3-40 Save to Favorites 

(3) Favorites in the existing base station coordinates, click < Choose from Favorites > to enter the 
Favorites interface to select the base station coordinates need to be replaced. 

(4) Click < OK > to complete the replacement of base station coordinates (Figure 3-41). 

 
Figure 3-41 Select from Favorites 

2. Parameter setting 
The parameter settings include raw data check, point cloud data resolution, quality inspection, 

navigation belt correction, point cloud coloring, point cloud output, and topographic results export; 
point cloud data resolution is checked by default, and the detailed introduction of other capabilities 
can be viewed in 3.3.10-3.3.20 in this document. 
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Figure 3-42 Parameter settings 

After the configuration is completed, click [OK] and the software will automatically process the 
engineering data. The processing progress is displayed in the right information output bar and the 
progress bar in the lower left corner. 

 
Figure 3-43 Automatic processing 

After the data is processed, the processed point cloud will be automatically loaded into the 
navigation editing panel. 
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Figure 3-44 Point cloud loading 

3. Coordinate system setting 
Coordinate system settings include projection, datum, ellipsoid transformation, plane 

transformation, height fitting, grid, translation parameter, option, parameter calculation, import, and 
coordinate system management (Figure 3-45). 

 
Figure 3-45 Coordinate system settings 

(1) Projection 
The "Projection" tab is used to transform the projection and set the related parameters (Figure 3-45). 

 
Figure 3-46 Projection 
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(2) Datum 
Users can select or set the corresponding source ellipsoid and target ellipsoid name (if the 

ellipsoid is pre-built in the software, the ellipsoid parameter under the corresponding target ellipsoid 
name will be loaded automatically and the ellipsoid parameter is not editable).  

 
Figure 3-47 Datum 

(3) Ellipsoid transformation 
The transformation models are as shown in Figure 3-48. 
⚫ Bursa-Wolf Transformation, Molodensky, One-touch can be obtained after parameterization, 

while the rest require inputting the corresponding values. 

 
Figure 3-48 Ellipsoid transformation 

(4) Plane transformation 
Different parameters can be modified by selecting different transformation models (Figure 3-49). 
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Figure 3-49 Ellipsoid transformation 

(5) Height fitting 
The transformed models are as shown in Figure 3-50. 
⚫ The FreeSurvey Elevation Fitting obtains the elevation fit parameters from the results of the 

parameter calculation, height fitting can be done by selecting the required model and filling in 
the relevant parameters. 

 
Figure 3-50 Height fitting 

(6) Grid correction 
The supported grid types are as shown in Figure 3-51. 
⚫ Users can select the corresponding plane correction grid type.  
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⚫ The grid switch is off by default, and the grid file drop-down box on the right side is not selectable, 
when the switch is turned on, the imported grid file can be selected from the grid file drop-down 
box on the right side. 

 
Figure 3-51 Grid 

(7) Translation parameter 
The translation parameter is mainly used for the point panning function of Sat-Survey or SGS RTK 

module (Figure 3-52). 

 
Figure 3-52 Translation parameter 

(8) Option parameters 
The adjustable parameters are shown in Figure 3-53. 
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Whether the file is encrypted or not:  
⚫ if the dam body parameter file (upgraded, version number is greater than or equal to 17) is 

encrypted, you can check whether the coordinate system date is outdated, and you can't 
edit the ellipsoid parameters; 

⚫ If the dam parameter file (not upgraded, version number less than 17) is encrypted, the 
ellipsoid parameters can be edited. 

When creating a new coordinate system, the latitude and longitude range configuration item is 
turned off by default, and the user can set the maximum and minimum range of the coordinate system 
latitude and longitude. 

 
Figure 3-53 Option 

(9) Parameter calculation  
a) Click the [Parameter Calculation] button to enter the parameter calculation interface, ensure the 

projection and datum information are correct before calculation. 
b) Click the [Open] button to select a parameter calculation file. Supported formats: parameter 

calculation point pair file (*.txt), Carlson localized parameter file (*.loc), custom (*.txt). 
c) Select the file type and corresponding file, then click OK to import and display the point pairs in 

the list. 
d) Click [Add] to manually enter and confirm point pair coordinates, which will be displayed in the 

list. 
e) Choose a calculation type and click [Calculation] to display the results based on the input point 

pairs and calculation type. 
f) Click [Save] to save the custom parameter point pairs and click [Apply] to automatically fill in the 

parameters on the corresponding tab page. 
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Figure 3-54 Parameter calculation 

(10) Import 
Click the [Import] button to open the file selection window, elect the corresponding coordinate 

parameter file (DAM or DC format), click OK. The successfully read coordinate system file will update 
the parameters in the projection, datum, and plane transformation configurations in the coordinate 
system setting interface.  

(11) Coordinate system management. 
a) Click [Coordinate System Management] to enter the interface. 
b) Click [Predefined] radio box to select a continent to show corresponding countries and their 

coordinate systems. 
c) Click the [User Defined] box to display the custom coordinate system list, click a coordinate 

system to see its details on the right, but the name cannot be edited. 
d) Select a custom coordinate system file and click [Delete] to remove it. 
e) Click [Download] to download predefined coordinate system and grid files. 
f) Click [Update Built-in Ellipsoid] to automatically update ellipsoid parameters. 
g) Click [New] to clear the coordinate system name, enter a new name, edit parameters, and click 

[Save] to save. 
h) Click [Apply] to apply the selected coordinate system, and then click [Cancel] to close the 

interface. 
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Figure 3-55 Coordinate system management 

3.3.2 Trajectory Solving 

1. Click menu <Solve>→<Trajectory Solving> to open the solving interface (Figure 3-56);  

 
Figure 3-56 Base station information 

2. For details of local trajectory solving function, please refer to the base station setting in 3.3.1. 

3. If you need to generate complete trajectory pos:  

(1) uncheck the "Eliminate redundant data ";  

(2) check "Solve all Projects" . 
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4. It will solve all pos trajectorys under the current project with the currently input base station 

coordinates as the base station. 

5. After the configuration is completed, click <Start to calculate> and then the software starts to 

solve the trajectory pos, after the solving is completed, the solved pos trajectory is loaded in the 

main view and loaded into the editing column of the aerial tape (Figure 3-57). 

 
Figure 3-57 Local trajectory solving 

3.3.3 Combine Setting 

Selecting the POS project and point cloud file, set the combine parameters for the POS project 

and point cloud file respectively. 

The combine function mainly utilizes the POS data to transfer the scanned point coordinates in the 

original scan file to the geodetic coordinate system, and the output results include: target point cloud 

file, POS track file (lin), where the lin file is created by default. 

You need to set some parameters before fusion, right-click on the project node or point cloud node 

in the file view and Click the "Combine Settings" menu to make the relevant settings. 

Note: 

(1) The Combine Settings dialog box is a non-modal dialog box. After the Combine Settings dialog 

box pops up, left-click different tree nodes on the workspace list, the Combine Settings dialog box will 

update the settings accordingly.  

(2) After setting the parameters in the Combine Settings dialog box of a point cloud node, you can 

choose to apply them to the point cloud file, the current project or the whole combine project in one 

of the three ways. 

⚫ Start: click <Solve>→<Begin Combine>, you can open the log output box to view the log 

information.  
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⚫ Terminate: click <Solve>→<Stop Combine> to stop the combine process. 

1.POS Project Combine Setting 

Select the current project in the project management panel, right-click the menu and click 

<Combine Setting>, or click the tool button    on the toolbar to bring up the POS Project Combine 

Setting dialog box (Figure 3-58). 

 
Figure 3-58 Project Combine Settings  

(1) Combine 

The "Combine" Tab Page is divided into 4 sections from top to bottom (Figure 3-59). 

 
Figure 3-59 Combine Tab Page 

i) Combine Mode:  

⚫ Complete Combine Mode : Combine all data which can change the proportion. 
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⚫ Control Point Combine Mode: Indicates that the combine is performed according to the radius 
distance of the imported control point file; 

⚫ Local Derivation: the on-board data fuse and output the POS file selected by the local box, and 
the onboard data fuse the drawing POS cutting area. 

ii) Combine object: 

 Combine output is performed using a single point cloud file, iScan project, or POS project as the 

basic unit. For example, if the combine mode is complete combine mode and the combine object is 

POS project, all the point clouds in the whole POS project will be merged into one point cloud file for 

output. 

iii) Export Format: you can choose one or more of the three target point cloud formats: hlz, las, xyz. 

iv) Format attribute settings: including hlz attribute settings, las attribute settings and xyz attribute 

settings.  

a) hlz attribute settings include hlz3.2 and hlz3.3 two versions; 

b) las attribute settings: 

⚫ las attribute settings include las version, time type, and whether or not to export by 

volume.las format currently supports the following versions: 1.0-1.4, which 1.0-1.3 version 

scanning angle value is -90 to 90 degrees, 1.4 scanning angle value is -180 to 180 degrees. 

⚫ The scanning direction with a 1 indicates that the left to right, 0 indicates that the right to 

left, the bottom of the left for the negative, the bottom of the right for the positive;  

⚫ The time type currently supports the GPS standard time and the GPS seconds of the week;  

⚫ las format support for the sub-volume export function, the support of the size of the sub-

volume are: 512M. 1024M, 2048M,4096M. 

c) the xyz format supports customizing the content and order of the fields, mainly including: 

coordinates X, Y, Z, intensity, time, echo sequence number, echo number and other fields. 

(2) Other 

The "Others" tab is shown in Figure 3-60. 

i) Custom hdi file: After checking the box, another hdi file will be created in the directory of the 

standard hdi file, the file name is "iScan-Image-custom.hdi", and the exposure time in the file will be in 

weeks and seconds using GPS, and the contents and order of the fields can be customized. 
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Figure 3-60 Other setting 

ii) Camera parameter: After checking the box, when combine outputs the hdi (POS attitude 

parameter of the camera at the moment of exposure) file, it will output the camera's external parameter 

file at the same time, with the same output path, and the name of the file is "iScan-Image-external.txt", 

and the contents and the order of fields in the camera's external parameter file can be customized.  

iii) Denoising: denoising removes noise by spatial features, which is used to select according to 

whether the current fused point cloud needs to retain the power line features or not, if the collected 

data does not contain power line data, then select non-power line denoising, if the collected data 

contains power line data and needs to retain the complete power line point cloud, then select power 

line denoising. 

⚫ Number of Near Neighbors: indicates the number of points near the target point used for 

counting when calculating the distance between the target point and the point cloud. The larger 

the value is, the more points are involved in the calculation, the larger the search range is, the 

filtering threshold calculated applies to more points, and the denoising effort is smaller, and vice 

versa the denoising effort is larger. 

⚫ Filtering threshold: a coefficient when calculating the filtering threshold, the larger the value is, 

the larger the calculated filtering threshold is, the smaller the denoising strength is, and vice versa, 

the larger the denoising strength is. 

2.Point cloud file combine settings 

Project management panel select the point cloud file, right-click menu click <Combine Settings>, 

the point cloud file combine settings dialog box pops up (Figure 3-60), from top to bottom is divided 

into 6 parts. 

(1) Time: After checking the box, click the button <Time Period>, in which you can enter multiple 
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time periods or pick up the time from the POS track.  

(2) Distance: The distance represents the distance of the scanning point from the scanner, after 

checking the box, click <Distance Segment>, in which you can set multiple distance segments for 

filtering. 

(3) Field of view: including non-fixed angle and fixed angle, fixed angle will be automatically hidden 

in onboard mode; non-fixed angle represents the scanner's angle of rotation when scanning (multi-line 

scanners need to determine the scanning direction of rotation), the range of the field of view is -180 

degrees to 180 degrees. In onboard mode, the field of view is checked by default and ranges from -45 

degrees to 45 degrees. Fixed angle range of 0-360 degrees, the default is 50 degrees, equivalent to 

non-fixed angle input -25 degrees to 25 degrees. 

(4) POS Height: This height indicates the height of the scanning point relative to the POS center. 

(5) Range: Define the range of the rectangle area by setting the coordinates of the upper-left and 

lower-right corners of the rectangle, the coordinate system to which the coordinates belong is the 

coordinate system defined in the "Coordinate System" page. 

(6) Reverse Filtering:  

⚫ Check the corresponding filtering indicator to indicate that "the point cloud with the indicator 

in the specified range will be filtered out and will not be fused to the output". 

⚫ Unchecked to indicate that "the point cloud with the indicator not in the specified range will 

be filtered out and will not be fused to the output". 

 
Figure 3-61 Filtering Setting 
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3.3.4 Begin Combine 

1. Open the combine project, project management panel check the need to fuse the project. 

2. Click the menu <Solve>→<Begin Combine>, or click the toolbar tool button 【 】, to start 

fusing the data, the status bar displays the progress of combine and combine of the 

information output in the log view (Figure 3-62).  

3. Combine is complete, the log view will be "combine success" message prompt. 

 
Figure 3-62 Start combine 

3.3.5 Stop Combine 

In the process of data combine, you can click menu <Solve>→<Stop Combine> to stop the current 

combine. 

3.3.6 Strip Rectify 

This function mainly deals with the non-overlapping point clouds of neighboring air strips through 

the algorithm, so that the air strips overlap to the maximum extent.  

1. Open the combine project in the project management panel, load and display the point cloud 

files, click  <Solve>→ < Trajectory Rectify >, and then "Trajectory Rectify" box pops up (Figure 3-62). 

2. Select the flight that needs to perform aerial tape correction, select the corresponding POS file 

and point cloud file. 

3. Add target control points (if any) Select the target points for automatic target point identification 

operation, click OK to start the Trajectory rectification. 

4. After the completion of the rectification, the corrected point cloud will be automatically loaded 

into the view, and the Trajectory rectification report will be output in the Point Cloud Output Catalog, 

which displays the corrected point cloud, as well as the minimum error, maximum error, and RMS of the 
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Trajectory rectified, if the control points are used for xyz rectification, the coordinates of the control 

points and scan points before and after calibration are additionally displayed, as well as the error. 

⚫ List of Flights: support to create new flight, add flight file (.hdc), remove flight file; add 

duplicate flight, there will be an error message; 

⚫ List of Trajectory Files: supports adding POS data and removing POS data for the currently 

selected flights.; 

⚫ List of Point cloud file: support adding point cloud data and removing point cloud data for the 

current selection; use hlz format point cloud correction, and the corrected hlz point cloud 

format is hlz3.4 format. 

⚫ Add control point: support selecting control point to xml file, support editing control point for 

target identification corresponding to the scanning point. 

(1) Control point list: you can change the type of one or more control points to control point 

or check by right clicking. 

◆ Control point: participate in Trajectory rectify correction,  

◆ Check: not participate in correction, participate in the output of the accuracy report after 

correction. 

(2) Auto Identify Target Points: Click the button of Auto Identify Target Points on the dialog  

box of Control Points List, the program will automatically search for square checkerboard targets in the 

Control Points Attachment, and 50cm*50cm targets are supported at present. There is an option to 

choose xyz correction or z correction on the dialog box. 

◆ z correction: only the z coordinate of the control point will be used, and the final result is 

that only the z coordinate of the point cloud will be involved in the correction;   

◆ xyz correction: the xyz coordinate of the point cloud will be used, and the final result is 

that the xyz coordinate of the point cloud may be modified. 

 
Figure 3-63 Strip ajustment dialog box 
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3.3.7 Point Cloud Smoothing 

1.   Click the menu <Solve>→<Point Cloud Smoothing>. 

2. The default point cloud displayed in the point cloud file list is the point cloud checked and 

displayed in the air strip editing panel, check the point cloud that needs to be smoothed by 

the point cloud, and set the radius of search, which is 0.2 by default.  

3. Click [OK], point cloud smoothing generates point cloud files with a "processed“ suffix. 

4. If you use the hlz format point cloud for point cloud smoothing, the finished point cloud will 

be in the hlz3.4 format. 

 
Figure 3-64 Point Cloud Smoothing dialog box 

3.3.8 Point Cloud Colorize 

Airborne point cloud color assignment includes two aspects: Original Image and ortho image.  

1. Original Image colorize 

Click “Point Cloud Colorize“ to open the point cloud color assignment dialog box. 

(1) if the corresponding combine project has been opened, the corresponding point cloud will be 

loaded automatically, if the fused point cloud in the cut tape of the tape editing panel will also 

be loaded into the interface automatically. 

(2) If use the hlz format point cloud for original image colorize, the point cloud after colorize will 

be in hlz3.4 format.  

⚫ Enter point cloud catalog: default is POO catalog. 

⚫ Output point cloud catalog: the output point cloud file name is automatically named as 

the original file name plus "_colorize". 
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Figure 3-65 Point cloud colorize dialog box 

The effect of color assignment is shown in Figure 3-66 and Figure 3-67: 

 
Figure 3-66 Overall point cloud Original Image colorize effect 

 

Figure 3-67 Original Image colorize 
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2.Ortho Image colorize 

(1) If a folder named DOM exists in the project directory, and the folder holds orthophotos in TIF 

format, it will be loaded into the interface automatically;  

(2) If the DOM folder does not exist, you need to manually select the path of the tif orthophotos. 

(3) If use the hlz format point cloud for Ortho Image colorize, the point cloud after colorize will be 

in hlz3.4 format. 

 
Figure 3-68 Ortho Image colorize Dialog Box 

(4) Select a project in the project management panel, right-click <Point Cloud Colorize> to assign 

color to a single project, or click <Solve> → <Point Cloud Colorize> to assign color to all the 

checked projects.  

(5) After the color assignment is completed, it will automatically reload the successfully assigned 

point cloud and display the color assignment effect in true color rendering (Figure 3-69). 

 
Figure 3-69 Ortho Image colorize effect 
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3.3.9 Point Cloud Export 

Click menu <Solve>→<Point Cloud Export> to bring up a dialog box (Figure 3-70). Users can 
select the desired export options, output format, point cloud attributes to customize the export. 
Export options:  

⚫ Regular Export: complete export. 
⚫ Segmented Export: each original scan file is exported to multiple target point cloud files 

according to GNSS time segments. 
⚫ Rectangle Framing: each original scanned file is exported to multiple point cloud files 

according to the polygons in the polygon file, and the polygons involved in the export can be 

set by the field values (Figure 3-71). 

⚫ Volume Export: the point cloud data can be exported to multiple files according to the set size 

(this setting is only valid for las format point cloud). 

⚫ Output formats: include hlz, las and xyz, and the export format can be multi-selected.  

Click the Export button to export the selected point cloud. 

 
Figure 3-70 Main interface of point cloud export 
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Figure 3-71 Split export settings 

3.3.10 Related Control Points 

1. Click the menu <Solve>→<Related Control Points> to support the associated txt format and 

csv format control points.  

2. After selecting the control point file, click OK to open the ASCII file window (Figure 3-72), 

supports the setting of how many lines in front of the control point is ignored; 

3. You can also set the control point of the specific meaning of each column of data (control point 

name, x, y, z), set up, click on the application, the control point is associated with the current 

point cloud.Support associated control points in txt format and cpt format. 

 
Figure 3-72 Related Control Points 
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3.3.11 Accuracy Inspection 

Load the point cloud and associate it with the control points of the point cloud, click <Solve>→

<Accuracy Inspection> (Figure 3-73).  

Accuracy check provides two ways to select points manually and automatically. 

1. Manual point selection: Select the scanning point to check the accuracy with the control point 

to get the result of accuracy checking.  

(1) Click "Accuracy Check" to open the magnifying glass view for point selection. Left-click 

to select the matching scanning point for each control point. 

(2) After the scanning point is successfully selected, the right side of the control point in the 

control point list will be filled with the corresponding scanning point (Figure 3-74). 

(3) If you are not satisfied with the selection, re-locate or manually adjust the scanning point 

coordinates and press Enter to confirm. 

(4) After selecting all scanning points, click "Display Results" to calculate data accuracy 

(Figure 3-75).  

(5) Click "Export Report" to save the report and jump to the report saving interface (Figure 

3-76). 

2. Auto Search: Accuracy checking is carried out by means of automatic searching of elevation 

points by the program, and the auto search function is generally applicable to the points of 

elevation type.  

(1) Clicking Auto Search, the program will automatically detect the coordinate position of 

the scanning point corresponding to the control point (Figure 3-77), the other operations 

are consistent with Quick Point Selection. 

The center error  in the z-direction is calculated by the formula: 

 

The center error  in the z-direction is calculated by the formula: 

 
The center error  in the z-direction is calculated by the formula: 

 

The formula for calculating the center error in the plane is: 
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where 、 、  indicate the coordinate error values of the scanning point and the control point 

in X, Y and Z directions respectively. 

 
Figure 3-73 Accuracy Inspection main interface 

 
Figure 3-74 Starting point selection 

 
Figure 3-75 Accuracy Inspection 
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Figure 3-76 Export Report 

 
Figure 3-77 Accuracy Inspection interface after auto search 

 
Figure 3-78 Delete Scan Points 
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Figure 3-79 Changing point type 

Types of control points: including ordinary, plane and elevation control points, plane control points 

are only valid for X and Y coordinates, elevation control points are only valid for Z coordinates. 

Point selection methods: ordinary point selection, fitting intersection, fitting center of circle, fitting 

circular target, fitting checkerboard target.  

⚫ Ordinary point selection: directly in the magnifying glass view of the left click to select the 

point; fit intersection is based on the identification of the intersection of two lines to determine 

the point of selection (Figure 3-80). 

⚫ Fit the center of the circle: click on the magnifying glass view to select two points to determine 

the diameter of the circle, move the mouse to determine the shape of the circle, at this time 

the center of the circle is to determine the point (Figure 3-81).  

⚫ Fitting a circular target: based on the selected point cloud, the center of the target is 

automatically fitted (Figure 3-82).  

⚫ Fitting a checkerboard target: select the center point position for the checkerboard grid points 

(Figure 3-83). 

 
Figure 3-80 Fitting the intersection 
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Figure 3-81 Fitting the center of a circle 

 
Figure 3-82 Fitting Circular Targets 

 
Figure 3-83 Fitting a checkerboard target 
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3.3.12 Point Moving 

Load the relevant point cloud data, click <Solve>→<Point Moving>. Point Panning provides the 
setting of xyz three-direction panning amount, enter the value, click “OK”, automatically loaded into 
the view when done. 

 
Figure 3-84 Point Moving dialog box 

3.3.13 Original Data Check 

1. Open the combine project in the project management panel and click <Solve>→<Quality Check> 

→ <Original Data Check> to open the "Original Data Check" box (Figure 3-85).  

2. The original data quality check includes four items: data integrity check, scan data check, image 

data check and pos data check. Select the check items to be checked by checking the boxes. 

⚫ Data Integrity: Check whether there is any missing scan data, image data and pos data. 

⚫ Scan data: Checks the size of the original scan data. 

⚫ Image data: Check if the image and syn match. 

⚫ POS data: Check if there is any abnormality in pos data. This is done by setting a change 

threshold for the POS anomaly check item, above which it will be detected and reported as an 

anomaly. 

3. Optionally fill in the survey area, weather, inspectors, and related information.  

4. Click "Quality Inspection and Export" to check the raw data.  

5. Once completed, the PDF report is automatically exported, and the folder opens. 
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Figure 3-85 Original data check screen 

3.3.14 Flight Route Quality Check 

Open the combine project in the project management panel, load the display point cloud file.  

1. Click <Solve> → <Quality Check> → < Flight Route Quality Check> (Figure 3-86).  

2. Click button 【 】 to add the cropped POS track in the track list. 

3. Click button 【 】to delete the selected POS track from the track list. 

4. Fill in the location of the survey area, weather conditions, and inspectors.  

The system will automatically recommend the altitude, speed and curvature parameters according to 

the data, and the user can set the parameters according to the project requirements.  

After the setting is completed: 

1. Click ''Start Inspection'', the route quality will be inspected, the results of altitude, speed and 

curvature will be displayed in the Route Quality Inspection interface (Figure 3-86). 

2. Optionally fill in the measurement area, weather, and inspector details.  

3. Click "Quality Check and Export" to begin the route inspection.  

The report will be automatically generated in PDF format, and the folder will open upon completion. 

 
Figure 3-86 Flight Route Quality Check dialog box 
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Figure 3-87 Flight Route Quality Check Results 

(1) Altitude Analysis: The report contains the name of each air strip, the minimum altitude, 

maximum altitude, average difference between the maximum and minimum altitude, altitude variance, 

average altitude of the air strip, and whether the air strip is qualified or not according to the design 

altitude and altitude tolerance set by the user. 

(2) Speed Analysis: The report contains the name of each air strip, the minimum air speed, maximum 

air speed, average difference of maximum and minimum air speed, air speed variance, average air 

speed, as well as the speed consistency parameter set by the user to judge whether the air strip is 

qualified or not. 

(3) Flight Attitude Analysis: The report contains the name, maximum roll angle, average roll angle, 

maximum pitch angle, average pitch angle, course curvature (%) of each air strip, and whether the air 

strip is qualified or not according to the course curvature threshold set by the user. 

3.3.15 Strip Overlap Analysis 

1. Open the combine project in the project management panel, load the display point cloud file. 

2. Click the menu <Solve> → <Quality Check> → <Strip Overlap analysis> (Figure 3-88).  

3. The default grid size is set to 2 meters, and the overlap threshold is 30%. After clicking the 

Quality Check button, the program will check the overlap rate of the zones (Figure 3-89). 

4. You can selectively fill in the location of the survey area, weather conditions, inspectors and 

related information. 

5. Click on the "quality check and export ", the program begins to carry out the overlap analysis 

of the zones. 

After the completion of the inspection, the report is automatically exported (pdf format), the report 

automatically opens the folder after the completion of the folder. 
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Figure 3-88 Analysis Of Strip Overlap 

 
Figure 3-89 Strip Overlap Analysis Results 

3.3.16 Height Different Quality Check 

Open the combine project in the project management panel, then load and display the point cloud 

file. In the main interface, click <Solve> → <Quality Check> → <Height Difference Quality Check> to 

open the dialog box (Figure 3-90).  

⚫ The default grid size is 2 meters, and the critical threshold is 0.5 meters. Click the <Quality 

Check> button to start the check with a 30% threshold.  

⚫ Optionally, fill in the survey area location, weather conditions, and inspector details. Once you 

click the quality check button, the program will perform the height difference quality check, 

with results displayed in Figure 3-91. 

After the check, you can optionally provide the survey area location, weather conditions, and 

inspector details, then click "Quality Check and Export." The program will perform the height difference 

quality check again and automatically export the report in PDF format, which will open automatically 

once complete. 
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Figure 3-90 Height Different quality check dialog box 

 
Figure 3-91 Result of height Different quality check 

3.3.17 Density Quality Check 

1. Open the combine project in the project management panel, load and display the point cloud 

files. 

2. Click <Solve> → <Quality Check> → <Density Quality Check> in the main interface to pop up 

the dialog box (Figure 3-92).  

3. The default grid size is 2 meters, and the average density threshold is 10 points per square 

meter. You can add or remove point cloud files as needed. Click "Start Check" to begin the 

density quality check, and the results will be displayed (Figure 3-93). 

4. You can optionally fill in the survey area location, weather conditions, and inspector 

information.  

5. Click "Quality Check and Export" to start the density quality check.  
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Once the check is complete, the program will automatically export the report in PDF format, which 

will open automatically when finished. 

 

 
Figure 3-92 Density Quality Check dialog box 

 
Figure 3-93 Density quality check results 

3.3.18 Coverage Quality Check 

1. Open the combine project in the project management panel, load and display the point cloud 

files. 

2. Click <Solve> → <Quality Check> → <Coverage Quality Check> in the main interface to pop 

up the dialog box (Figure 3-94).  

3. Set the grid size parameters as needed, and import the range line files from the top view of 

the cloud (.shp/.dxf/.dwg).  

4. Optionally, fill in the survey area location, weather conditions, and inspector information.  

5. Click "Quality Check and Export" to start the completion rate check.  
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Once the check is finished, the program will automatically export the report in PDF format and 

open the folder containing the report. 

 
Figure 3-94 Point cloud range check dialog 

3.3.19 Automatic Quality Check 

This tool allows users to run multiple quality checks in one click and export a report. 

Steps: 

1. Open Project 

In the Project Management panel, open the fusion project and load the point cloud. 

2. Start Auto QC 

Click Solution > Quality Check > Auto Quality Check. 

The Auto QC window will open. 

3. Select Checks & Set Parameters 

o Select the quality check items you need (all are selected by default). 

o Input the required parameters or files for each check. 

o (Optional) Fill in survey location, weather, and inspector name. 

4. Run and Export 

Click Run Check and Export. 

The software will process the selected checks and generate reports. 
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Reports are saved in the “Quality Check” folder under the POS project directory. 

Notes: 

• If Flight Line Check is selected, you must input designed flight height and designed 

speed. Otherwise, an error will be shown, but other checks will still run. 

• If Coverage Check is selected, the boundary file must be fully covered by the point cloud 

top view. If not, an error will be shown, but other checks will still run. 

• If no checks are selected, the software will show an error and stop. 

 
Figure 3-95 Automatic Quality Check dialog box 

3.3.20 Point Cloud Processing 

Click menu <Solve>→ <Point Cloud Processing>, it will close the current project, uninstall the 

project, and load the hlz point cloud in the layer panel. 

⚫ If there is a colorized point cloud, i.e., the file name has "449480.99-449507.01_colorize.hlz", 

it will prioritize to load colorized point cloud. 

⚫ If there is no colorized point cloud, it will still load the fused point cloud.  

3.3.21 Generate DOM 

When generating an orthophoto (DOM) from point clouds, please note that this feature has 

minimum hardware requirements. An NVIDIA graphics card is required, with a model RTX 2060 or above, 

and at least 4 GB of VRAM. The computer must also have CUDA version 10 or higher installed. 

If the system does not meet these requirements, the software will display a warning indicating that 

the computer configuration is insufficient. 

When the hardware requirements are met, the airborne dataset to be used for DOM generation has 

been loaded, and the trajectory has been processed and trimmed, clicking Generate DOM will open 

the configuration dialog. Two processing options are available: Quick Mode and Professional Mode. 
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Figure 3-95 Generate DOM 

Quick Mode:The DOM is generated directly within Hi-Lidar. Once the log indicates that the DOM 

generation is complete, you can find the resulting TIF file in the project data directory. 
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3.4 Tools 

3.4.1 Measurement tools 

1. Measure 3D Distances 

(1) Click the menu <Tools> → <Measure 3D Distances>. 

(2) Click the left mouse button to draw, the measured distance data and line will be displayed in 

the view. 

(3) Double-click on the left mouse button to end the measurement line drawing (Figure 3-96).  

(4) Cancel: click <Measure 3D Distance> again. 

 
Figure 3-96 Measure 3D distances 

2. Measure 2D Distance 

(1) Click the menu <Tools>→<Measure 2D Distance>. 

(2) Click the left mouse button to select the node in the two-dimensional view of the measurement 

line drawing, the measured distance data and line will be displayed in the view. 

(3) Double-click on the left mouse button can be the end of the measurement line drawing (Figure 

3-97).  

(4) Cancel: click <Measure 2D Distance> again. 

 
Figure 3-97 Measure 2D distance 

3. Measure Density 

(1) Click the menu <Tools> → <Measure Density>.  

(2) Press the left mouse button to select the scope of the density, lift the left mouse button, the 
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density of the box within the scope of the point data will be displayed (Figure 3-98).  

(3) Cancel: click <Measure Density> again. 

 
Figure 3-98 Measure Density 

4. Measuring Slope 

(1) Cick the menu <Tools> → <Measure Slope>. 

(2) Click the left mouse button to select the two points that need to calculate the slope, draw the 

slope line (Figure 3-99), the drawn slope value is displayed in real time on the view.  

(3) Cancel: click <Measure Slope> again. 

 
Figure 3-99 Measure the slope 

5. Measure Angle 

(1) Click the menu <Tools> → < Measure Angle >. 

(2) Click the left mouse button in the view to select the two points where the angle needs to be 

calculated, and then draw an angle line (Figure 3-100), the drawn angle value is displayed in 

real time on the view.  

(3) Cancel: click < Measure Angle > again. 



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  105  

 
Figure 3-100 Measuring Angle 

6. Measure Height 

(1) Click the menu <Tools> → <Measure Height>. 

(2) Click the left mouse button to select the two points that need to calculate the height, and draw 

a height line (Figure 3-101), the height value is displayed in real time on the view.  

(3) Cancel: click <Measure Height> again. 

 
Figure 3-101 Measure Height 

7. Measure Area 

(1) Click the menu <Tools> → <Measure Area>. 

(2) Click the left mouse button to draw polygons at different locations in the view (Figure 3-102).  

(3) Double-click the left mouse button to end the drawing, and the value of the area within the 

polygon will be displayed in real time on the view.  

(4) Cancel: click <Measure Area> again. 
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Figure 3-102 Measure Area 

8. Measure Volume 

(1) Click the menu <Tools> → <Measure Volume>. 

(2) Click the left mouse button to draw polygons in different locations in the view, double-click the 

left mouse button to end the drawing. 

(3) The Measure Volume Settings dialog box pops up (Figure 3-103), where relevant parameters 

can be set. Click the <OK> button, the volume value within the polygon is displayed on the 

view (Figure 3-104).  

(4) Cancel: click <Measure Volume> again. 

 
Figure 3-103 Measure Volume setting 

 
Figure 3-104 Measure Volume 
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9. Measure Surface Area 

(1) Click the menu <Tools> → <Measure Surface Area>. 

(2) Click the left mouse button to draw polygons at different locations in the view (Figure 3-105), 

double-click the left mouse button to end the drawing, set the size of the grid, click OK, and 

the surface area value within the polygon will be displayed in real time on the view.  

(3) Cancel: click <Measure Surface Area> again. 

 
Figure 3-105 Measure Surface Area 

3.4.2 Selection tools 

1. Polygon Selection 

(1) Click the menu <Tools> → <Polygon Selection>. 

(2) Click the left mouse button to draw polygons in different locations in the view, double-click 

the left mouse button to end the drawing, the points within the polygon will be in the selected 

state and change the color (Figure 3-106).  

(3) The selected state of the point cloud color can be set in <File> → <System Settings> → 

<Selected Points Color>. 

 
Figure 3-106 Polygon Selection 

2. Rectangle Selection 

(1) Click the menu <Tools> → <Rectangle Selection>. 

(2) Click the left mouse button to draw a line, and then click the left mouse button again to draw 

a rectangular box, the points within the rectangle will be in the selected state and change the 

color (Figure 3-107). 
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(3) The selected state of the color of the cloud of points can be set up in the <Documents> → 

<System Settings> → <Selected Points Color>. 

 
Figure 3-107 Rectangle Selection 

3. Square Selection 

(1) Click the menu <Tools> → <Square Selection>. 

(2) In the view, click the left mouse button to draw a line, and then click the left mouse button 

again to draw a rectangular box, the points within the rectangle will be in the selected state 

and change the color (Figure 3-108).  

(3) The selected state of the color of the cloud of points can be set up in the <File> → <System 

Settings> → <Selected Points Color>. 

 
Figure 3-108 Square Selection 

4.Circle Selection 

(1) Click the menu <Tools> → <Circle Selection>. 

(2) In the view, click the left mouse button to determine the location of the center of the circle, 

move the mouse to the appropriate radius and then click the left mouse button again to draw 

a circular box, the points within the circle will be in the selected state and change the color 

(Figure 3-109). 

(3) The selected state of the point cloud color can be set up in the <Document> → <System 

Settings> → <Selected Points Color>. 
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Figure 3-109 Circle Selection 

5. Single Selection 

(1) Click the menu <Tools>→<Single Selection>. 

(2) The point cloud in the view is in the state of selection only at this time, and each time you 

select a point cloud it will cancel the last selected point cloud. 

6. Add Selection 

(1) Click menu <Tools>→<Add Selection>. 

(2) The selected point cloud in the view is in add selection point cloud state, and all the selected 

point clouds are set to selected state.  

7. Delete Selection 

(1) Click menu <Tools>→<Delete Selection>.  

(2) The point cloud selected in the view is decrease selection point cloud state, if there is a point 

cloud that is already in the selected state, cancel its selected state.  

8. Cut Unselected Points 

(1) Click menu <Tools>→<Cut Unselected Points>.  

(2) Only the point cloud with selected status will be retained in the current view (Figure 3-110). 
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Figure 3-110 Cut Unselected Point 

9. Cut Selected Points 

(1) Click the menu <Tools>→<Cut Selected Point>. 

(2) Only the point cloud with non-selected status will be retained in the current view (Figure 3-

111). 

 
Figure 3-111 Cut Selected Points 

10. Revoke Cutting 

Click menu <Tools>→<Revoke Cutting> to cancel the Cut Selected Point and Cut Unselected Point 

and display all point clouds. 

11. Export Cutting 

The function of Export Crop is to export the cropped point cloud to a separate file. 

(1) Click <Tools>→<Export Cutting > to bring up the dialog box (Figure 3-112), set the category 

of the exported point cloud, the format of the exported point cloud, the version of the 

exported format, and the path of the exported point cloud.  

(2) Click the <>>> button and <Properties> button to bring up the dialog box (Figure 3-113), 
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select and set the export category and export properties respectively. 

 
Figure -112 Export Cutting 

 
Figure 3-113 Exporting categories and properties 

3.4.3 Point selection tools 

1.Query Single Point 
(1) Click menu <Tools> → <Query Single Point>. 
(2) Click the point cloud that needs to be queried in the point cloud view, the pop-up dialog box 

(Figure 3-114) displays the detailed information of the point cloud, the point information can 
be copied to the clipboard by clicking <Copy>. 

 
Figure 3-114 Query Single Point details 

2. Query Multible Points 
(1) Click menu <Tools> → <Query Multible Points>. 
(2) A dialog box will be popped up (Figure 3-115), and then click the point cloud that needs to 

be queried in the point cloud view. 
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Figure 3-115 Multi-points query pop-up window 

(3) Click the point cloud in the view, the basic attribute information of the queried point cloud 
will be displayed in the multi-point query pop-up window, including: 3D coordinates, RGB, 
intensity, category and GPS time.  

(4) Add labels under the point cloud nodes in the workspace, click the labels in the workspace 
or the label line in the multi-point query pop-up window, the queried point cloud in the view 
is in the highlighted state (Figure 3-116), and the point pt1 is displayed in red. 

 
Figure 3-116 Multi-points query display 

3. Query POS Points 
(1) Load the POS track file. Click menu <Tools>→ < POS point query>, the "Query POS point" 

tool is activated, the cursor turns into the state of selecting a point 【 】. 
(2) Then click on the POS point that needs to be queried in the POS track (Figure 3-117), which 

displays detailed information of the queried POS point. 
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(3) You can copy the point information to the clipboard by clicking the button 【Copy】. 

 
Figure 3-117 Point Details dialog box 

4. Label Measurement Points 
(1) Click the menu <Tools>→ < Label Measurement Points >. 
(2) Select a feature point in the 3D view, click the left mouse button, will pop up the dialog box  

of the new annotation point (Figure 3-118), which already has a point of information, you can 
manually name the notes.  

(3) Click <Add Annotation> to complete the selection of annotation points (Figure 3-119). 

 
Figure 3-118 The New Annotation Point dialog box 
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Figure 3-119 Point labeling 

(4) After adding a markup point it will be automatically loaded into the markup layer in the 
workspace (Figure 3-120).  

(5) Right-click on the annotation point name to bring up a dialog box and click Remove to 
remove the annotation point name from the workspace and the annotation point from the 
view. 

 
Figure 3-120 Labeling Points in Layers 

(6) Click the right mouse button on the labeled node, the pop-up menu Figure 3-121, select 
<Save Data> in the menu, you can save all the labeled point information under the current 
labeled layer to a file.  

(7) Click <Import Data> in the menu to reload the saved annotation point information into the 
view and workspace. 

 
Figure 3-121 Saving and Importing Marking Points 

3.4.4 Other tools 

1. Point cloud format conversion 

(1) Click menu <Tools> → <Point Cloud Format Conversion>. 

(2) The point cloud list lists the point cloud files loaded in the current software, check the files 

that need to be formatted,  

(3) The <Merge and Export> check box can be set to whether to merge multiple input files for 

export, and you can select the format of the exported files, the format version and the path 

of the exported files below.  

(4) Click the <Properties> button, you can select the properties of the exported file. 

(5) Click <OK> to complete the export (Figure 3-123). 
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Figure 3-122 Point cloud format conversion 

 
Figure 3-123 Point cloud format conversion properties 

2. Remove Strip Edge Point 

(1) Click <Tools>→< Remove Edge Strip Point >. 

(2) The point cloud files are listed in the list of point cloud files loaded in the current software, 

check the files that need to be removed from the tape edge points, and then click <Start 

Execution>. 

(3) After the removal is completed, the pop-up dialog box will show "Whether to load the point 

cloud after cropping? After the removal is finished, a popup will appear, "Do you want to load 

the removal point cloud?", click "Yes" to load the removal point cloud into the view. 

 
Figure 3-124 Remove Strip Edge Point  
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3.5 Process 

3.5.1 Section View 

Click menu <Process> → <Section View> on the main interface, a new Profile View window is 

added to the main view, and a new Profile Options menu is added to the menu, the contents of the 

Profile menu will be introduced in subsection 3.8. 

3.5.2 Point Cloud Tiling 

The main purpose of the point cloud staging is to staging the point cloud according to a certain 

standard, generate the staging vector information, and then extract each small piece of point cloud 

through <Process>→<Select Tiling Block> for individual operation.  

1. Click menu <Process> →<Point Cloud tiling> to open the dialog box (Figure 3-125). The window 

lists the point cloud files currently loaded by the software, check the files that need to be staged. 

When more than one point cloud file is selected, the software will first merge multiple point 

clouds and then perform the staging.  

2. After selecting the file, you need to choose the splitting method and set the splitting parameters, 

when setting the customized block size and the number of blocks, users can refer to the box size 

information prompted in the window to make reasonable settings.  

3. Click <OK> when the settings are complete, the software will generate the vector file after the 

splitting and load it to the vector layer in the workspace and the view selected by the user in the 

splitting parameters (Figure 3-126). 

 
Figure 3-125 Point Cloud Tiling Settings 

 
Figure 3-126 Split Vector Generation 
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3.5.3 Select Tiling Block 

1. After generating split vector information through <Process>→<Point Cloud Split>, click menu 

<Process> → <Select Split Block> to activate the button, and then click on any split block in the 

Split Vector view to extract the point cloud in that block.  

2. After clicking on the 16th split block, the view will only show the point cloud in the block (Figure 

3-126), and at the same time, the software will automatically extract the part of the point cloud 

and generate a point cloud file to be loaded into the workspace, so that the user can operate on 

the part of the point cloud.  

3. If you want to extract the point cloud in more than one block, just click <Process> → <Select 

Split Block> button again and repeat the above operation. 

 
Figure 3-127 Select Split Block 

3.5.4 Automatic Classification 

1. This version of the software mainly has several classification methods of reset classification, noise 
filtering and ground point classification, which can realize batch combination operation.  

2. In <Process> menu bar, each classification method corresponds to <Reset Classification>, 
<Noise Filter>, <Ground Spot Classification> buttons respectively. 

3. After clicking the buttons, you can set the parameters of the corresponding classification 
methods, and the set parameters can be saved as templates and managed in <Process> → <Save 
Classification Parameters> and <Process> → <Manage Classification Templates>, and there is a 
selection box in front of each button to set whether or not the classification method is used. 

4. When the point cloud is categorized： 
⚫ If the point cloud format is hlz3.4, the category will be modified directly on the original file. 
⚫ If the point cloud format is a low version of hlz format, it needs to be automatically converted 

to hlz 3.4 format for categorization. 
⚫ After the conversion is completed, it will automatically overwrite the original low version of the 

point cloud data. 
5. When using las data classification: 
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⚫ If there is a hlz3.4 with the same name in the same directory, then directly use this hlz3.4 for 
classification.  

⚫ If there is a hlz3.2 or 3.3 with the same name in the same directory, then the program will 
automatically convert a hlz3.4 and overwrite the previous hlz to classify the point cloud. 

⚫ If there is no hlz with the same name in the same directory, then the program will automatically 
convert a hlz3.4, and use this converted point cloud to classify the point cloud. 

3.5.5 Reset Classify 

1. Click menu <Process> → <Reset Classify> on the main interface to bring up the dialog box 
(Figure 3-128) in which you can set the original category and target category for reset.  

2. Click <Save> to save the parameters to <Save Classification Parameters>.  

 
Figure 3-128 Reset classification 

3.5.6 Noise Filter 

1. Click menu <Process> → <Noise Filter> on the main interface to bring up the dialog box (Figure 

3-128), in which you can set the noise detection method, search radius and the minimum number 

of points within the search radius. 

2. Click <Save> to save the parameters to <Save Classification Parameters>. 

 
Figure 3-129 Noise Filter 

3.5.7 Classify Ground 

Click menu <Process> → <Classify Ground>, ground point classification is mainly divided into two 

ways: fabric algorithm and morphological filtering, and the parameters that need to be set up are shown 

in Figure 3-130.  
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When clicking the <Save> button, whichever Classify Ground way the current page is in will be 

adopted, and the parameters of the way will be saved to <Save Classification Parameters>. 

 
Figure 3-130 Classify Ground 

3.5.8 Median Ground Point 

Click menu <Process>→< Median Ground Point >, Median Ground Point Classification processes 
the points in the ground point category in the point cloud, extracts the layer in the z-direction which is 
in the middle, changes the category information to Median Ground Point, and writes it to the category 
attribute of the las point cloud. 

Median Ground Point can be set up with the grid size and standard deviation multiplier (Figure 3-
131). 

⚫ The bigger the standard deviation multiplier set up, the more ground median points will be 
categorized. 

⚫ The smaller the grid size is set, the better the ground median point categorization effect is, 
but the longer the time will be; the ground median point is unchecked by default. 

 
Figure 3-131 Median Ground Point 
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3.5.9 Reset Classify Parameters 

Click the menu <Process>→< Reset Classify Parameters> button (when the saved category 

parameter templates, the name of the button is the name of the selected template), a drop-down menu 

will pop up (Figure 3-132), the options in the menu include Reset Category Parameters and all the saved 

category parameter templates, and the name of the button is the name of the currently selected 

template.  

Click <Reset Classify Parameters> in the menu, you can reset the parameters of the current 

classification to the default, click a template can be set as selected. 

 
Figure 3-132 Reset Classify Parameters 

3.5.10 Partial Classification 

Click menu <Process> → <Partial Classification> to bring up the interface of local classification, 
check the specified range, click the box to select the range, draw the range in the view, fill in the 
parameters that need to be set up after completion, click Processing, and then classify the ground 
points in the boxed range again. 

 
Figure 3-133 Partial Classification 

3.5.11 Execute 

Click menu <Process> → < Execute > button, the interface shown in Figure 3-134 will pop up, 

which lists the list of data files loaded in the current software, you can select the files that need to 

perform the combination of classification. 
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After the selection is completed, click <OK>, the software will be in accordance with the 

parameters of the currently selected classification templates for the batch combination of the selected 

point cloud files for classification Process, and the classification effect will be displayed in the view.  

After the Process is completed, the classification effect will be displayed in each view. 

 
Figure 3-134 Execution windows 

3.5.12 Saving Classification Parameter 

After setting the parameters of each classification, click menu <Process>→<Save Classification 

Parameters> on the main interface, the information of each classification parameter is recorded in the 

interface (Figure 3-135), and when the font of the parameter information is grayed out, it means that 

the classification method is not selected.  

After entering a name in Template Name and clicking the <OK> button, you can save the current 

setting as a template.  

The newly saved template will be automatically added in the drop-down menu of <Reset 

Classification Parameters> and <Manage Classification Templates>, and at the same time, the <Reset 

Classification Parameters> button name will be synchronized with the name of the current template. 

 
Figure 3-135 Saving Classification Parameter 
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3.5.13 Manage Classification Template 

Click <Process>→< Manage Classification Template > button, the dialog box will be popped up 

(Figure 3-136), which lists all the category templates saved by the user, and when you click on one of 

the templates, the detailed parameter information of the template will be displayed underneath.  

⚫ Click <Delete> to delete the currently selected template. 

⚫ Click <Import> to import the template file from outside. 

⚫ Click <Export> to save the currently selected template information as a template file. 

 
Figure 3-136 Manage Classification Templates 

3.5.14 Manual Registration 

This function is mainly used for manual registration of SLAM point clouds. Registration is performed 
based on the same-name point pairs. Load the point cloud file to be registered, click the menu <Process> 
→ <Manual Registration>, enter the registration interface, the interface displays the base view, target 
view, and result view, select the point cloud file to be paired in the manual registration interface on the 
right, select the same-name point pairs in the base view and target view, the registration interface will 
display the stitching error value, and the result view will display the registration effect. If the current 
registration effect is satisfactory, click the Apply button to close the manual registration interface and 
return to View 1. View 1 displays the registration effect. Users can click <Airborne> → <Point Cloud 
Export> to export the registered point cloud file as needed. 
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3.6 Terrain 

3.6.1 Generate DEM 

This function is mainly used to generate relevant DEM model files locally. Click menu <Terrain>→

<Generate DEM>, the dialog box will pop up (Figure 3-137). 

1. You can select the point cloud data needed to generate the DEM model file, set the ground 

category and grid size of the generated model, the resolution size is divided into 1:500, 1:1000 

and 1:2000, corresponding to different grid sizes.  

2. Next, you need to set the format of the exported file, which is mainly tif and img.  

3. Since this function can batch generate DEM model files for multiple point clouds, you need to 

select the folder to save the batch files and click <OK> to start generating.  

4. After the generation of files need to be manually loaded in the software (Figure 3-138). 

 
Figure 3-137 Generate DEM 

 
Figure 3-138 Generated DEM model file 
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3.6.2 Generate DSM 

This function is mainly used to generate relevant DSM model files locally. 

1. Click the menu <Terrain>→<Generate DSM>, the dialog box will pop up (Figure 3-139). 

2. You can select the point cloud data that need to be generated to the DSM model file, and set 

the ground category and grid size of the generated model. 

⚫ The resolution size is divided into three kinds: 1:500, 1:1000, and 1:2000, which 

corresponds to different grid sizes, respectively.  

3. Next, you need to set the format of the exported file, which is mainly tif and img. As this 

function can batch generate DSM model files for multiple point clouds, you need to select the 

folder to save the batch files and click <OK> to start generating. The generated files need to 

be loaded manually in the software. 

 
Figure 3-139 Generate DSM 

3.6.3 Generate contour lines 

This function is mainly used to generate the related contour model file locally. 

1. Click <Terrain>→<Generate contour lines>, the dialog box will pop up (Figure 3-140). 

2. You can select the point cloud data that you need to generate the contour line model file, 

select the terrain type to which the point cloud data belongs, and set up the ground type, the 

starting value of the contour line, and  

⚫ The grid size for the generated model is divided into three kinds of grid resolution sizes: 

1:500, 1:1000 and 1:2000, corresponding to different grid sizes respectively.  

⚫ The grid resolution size is divided into three types: 1:500, 1:1000 and 1:2000, which 
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correspond to different grid sizes.  

3. Next, you need to set the format of the export file, which is mainly shp file. Since this function 

can generate contour model files for multiple point clouds in batch, you need to select the 

folder to save the batch files and click <OK> to start generating. After the generation of files 

need to be manually loaded in the software (Figure 3-141). 

 
Figure 3-140 Generate contour lines 

 
Figure 3-141 Generated contour model file 

3.6.4 Generate Elevation Points 

This function is mainly used to generate the related elevation point information text file locally, 

mainly including the number, x-coordinate, y-coordinate and corresponding elevation value.  

1. Click menu <Terrain>→<Generate Elevation Points>, the dialog box will pop up (Figure 3-

142). you can select the point cloud data that you need to generate the elevation point file, 
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set the ground category and the grid size for generating the elevation points. 

⚫ The grid resolution is divided into 3 kinds: 1:500, 1:1000, and 1:2000, which correspond to 

different grid sizes respectively.  

2. Next, you need to set the format of the export file, which is mainly dat, txt (NXYZ) and xyz 

(NXYZ) text file format. As this function can generate files for multiple point clouds in batch, 

you need to select the folder to save the batch files and click <OK> to start generating, the 

generated elevation point information file is shown in Figure 3-143. 

 
Figure 3-142 Generating Elevation Points 

 
Figure 3-143 Generated elevation point information file 
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3.6.6 Earthwork Calculations 

Under <Terrain> module, <Earthwork Calculation>, you can perform earthwork calculation, which 

mainly contains single-phase earthwork calculation and multi-phase earthwork comparison. The 

calculation format supports HLZ, LAS, Tif can choose the base elevation, set the range of calculation. 

1. Single-period calculation 

Single-period calculation is shown in Figure 3-145.  

For single-phase earthwork calculation, you need to select a point cloud file, which supports 

(HLZ,LAS.TIF) format. Down can be selected view imported files, the right side <...> can be exported 

from the local computer a point cloud file. The datum elevation can be set by the right side pull box, 

including minimum, maximum, average, self-selected points, customized.  

⚫ The self-selected point can be clicked directly from the view to get a datum elevation point;  

⚫ The customized one can be manually filled in an elevation value as the datum elevation.  

⚫ The grid size can be set by default, the grid size determines the density of thinning, the larger 

the value, the thinner the point cloud thinning, the lower the calculation accuracy, the faster 

the speed, when the calculation of the point cloud data is very large, you can increase the size 

of the parameter in order to get a faster calculation speed.  

⚫ The specified range can be unspecified or specified. The specified range can be read from a 

file, such as .shp, .dxf, .txt files, or the range can be selected from the view.  

Click Calculate and wait for the calculation result to pop up, as shown in Figure 3-146 After the 

calculation, you can export the results to (pdf, html, csv, xls, txt) format. 

 
Figure 3-145 Single-period calculation 
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Figure 3-146 Earthwork calculation results 

2. Multi-phase earthwork calculations 

Multi-phase earthwork calculations is shown in Figure 3-147. 

Multi-phase earthwork calculations at least join two periods of data for calculation. 

⚫ The right side of the list "+" can be added to the point cloud to the list, the default list of data 

behind the reference to the previous list of data, through the up and down arrows to adjust 

their reference logic. "-" can remove the selected data. 

⚫ Grid size sets the size of the extraction thinning, the same as the single-phase data, the default 

value is 5. The range designation is also consistent with the single-phase calculation.  

⚫ Click Calculate and wait for the calculation to pop up. After the calculation, you can export the 

results, support (pdf, html, csv, xls, txt) format. 

 
Figure 3-147 Multi-phase earthwork calculations  
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3.7 Layout 

3.7.1 Layer Management 

Users can show/hide the layer management panel according to their needs, checking means show 

and unchecking means hide. 

3.7.2 Properties Panel 

Users can show/hide the property panel according to their needs, checking means show, 

unchecking means hide. 

3.7.3 Toolbox 

Users can show/hide the Toolbox panel according to their needs, checking means show, 

unchecking means hide. 

3.7.4 Information Output 

Users can show/hide the message output panel according to their needs, checking the box means 

show, unchecking it means hide. 

3.7.5 Welcome Interface 

Users can display the welcome screen according to their needs, clicking the checkbox will bring up 

the welcome screen. 
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3.8 Profile Selection 

Profile menu is hidden by default, Click the menu <Process>→<Profile Selection> to automatically 

display the profile editing operation menu (Figure 3-148).  

At the same time, the Profile View window and the Profile Buffer Settings window are displayed 

(Figure 3-149), and the buffer size can be fixed by checking <Buffer> and setting the size in the window. 

Click the arrow part of the <Profile View> button, and then click <Buffer Setting> in the pop-up drop-

down menu to bring up the same window. 

 
Figure 3-148 Profile Edit Menu 

 
Figure 3-149 Setting the profile buffer 

3.8.1 Section Display 

Click the menu <Profile> → <Profile View>, enter the profile editing menu in the point cloud view 

to determine the profile line, and then determine the buffer size of the profile, as shown in Figure 3-

150, the profile operation is completed in two steps: 

1. Left mouse click on the start point and end point to determine the profile line (profile identification). 

If a fixed size buffer has been set, then at this point the software will automatically generate a buffer 

along the profile line, indicated by the yellow dashed box, without the need to carry out step 2; 

2. Not set a fixed size buffer, move the mouse perpendicular to the profile line, click the left mouse 

button to determine the size of the profile buffer.After the drawing is completed, the resulting profile 

view will be displayed in the Profile View window (Figure 3-151). 

 
Figure 3-150 View draws profile lines and buffers 
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Figure 3-151 Profile view display 

3.8.2 Moving the profile down 

Click the menu <Profile>→<Downshift Profile> icon part, the profile is downshifted according to 

the given step size, and the profile view is automatically updated after the downshift operation.  

Click menu <Profile>→<Downshift Profile> arrow part, click <Step Setting> in the drop-down 

menu, and set the size of the fixed step in the pop-up window (Figure 3-152). 

 
Figure 3-152 Step Size Setting 

3.8.3 Move Profile Up 

The Move Profile Up operation is the same as the Move Profile Down operation, and the operation 

structure is the opposite of the Move Down operation. 

3.8.4 Move Profile 

Click menu <Profile>→<Move Profile> to move the previously drawn profile markers in the main 

point cloud view with the mouse, and the profile editing view will be updated automatically after the 

mouse is released. 

3.8.5 Rotate Profile 

Click menu <Profile>→<Rotate Profile> arrow part, click <Rotate Setting> in the pop-up menu, a 

window like Figure 3-153 will pop up to set the rotation angle of the current profile. 

After closing the window and clicking menu <Profile>→<Rotate Profile> icon part, the profile view 
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will be rotated in accordance with the set angle, and the profile editing view will be updated to show 

the new profile view automatically. 

 
Figure 3-153 Profile rotation settings 

3.8.6 Extend profile 

Click menu <Profile>→<Extend Profile> arrow part, click <Extend Settings> in the pop-up menu 

(Figure 3-154), set the extension length of the profile, close the window and click menu <Profile>→

<Extend Profile> icon part, the profile view will be extended in accordance with the set length, and the 

profile editing view will be updated to the new profile view automatically. 

 
Figure 3-154 Profile Extension Settings 

3.8.7 TIN 

1. TIN Construction 

TIN Construction function targets the ground points in the currently displayed point cloud, and it 

can realize the browsing of TIN and the synchronous editing of point cloud and TIN.  

Load the chunked point cloud, click <TIN Construction>, check the point cloud to build TIN, click 

OK, wait for some time, the TIN will be built, and then you can browse the TIN in the same way as the 

point cloud. 

 
Figure 3-155 Constructing a TIN 
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2. Clear TIN 

You can click <Clear TIN> to clear the constructed TIN. 

3.8.8 Hide TIN 

You can hide TINs that are currently constructed and displayed. 

3.8.9 TIN Modes 

Three modes of rendering are supported: triangle mode, point mode, and solid mode. 

3.8.10 TIN Rendering 

Supports two rendering modes: monochrome rendering, elevation rendering 

3.8.11 Light-off 

Manually set the lighting on/off effect. 

3.8.12 Manual Classification 

Manual classification is mainly used to edit and modify the category of the point cloud by manual 

selection, which mainly includes: on-folding line classification, under-folding line classification, between-

folding line classification, polygon classification, brush classification, and single-point classification. 

1. Classification on the folding lines 

(1) Click menu <Profile>→<Classification on the folding lines> to bring up the Category Setting 

dialog box (Figure 3-156).  

(2) You need to set the initial category and target category in the dialog box, click the <>>> 

button, and you can make multiple selections for the initial category in the Select Category 

dialog box (Figure 3-157). 

 
Figure 3-156 Sorting Settings 

 
Figure 3-157 Select Category 



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  134  

(3) When the selection is complete, close the Classification Settings dialog box. Click the left 

mouse button anywhere on the profile view and drag the mouse to draw a folded box (Figure 

3-158).  

(4) During the drawing process, click the right mouse button to redraw, double-click the left 

mouse button to end the folding line drawing, located in the folding box inside the point cloud, 

all belong to the initial category of the point cloud's category will be set to the target category. 

 
Figure 3-158 Classification on Folding Lines 

2. Classification under folding Line 

The procedure is the same as < Classification on the folding lines >, and the direction of the drawn 

folding line box is downward (Figure 3-159). 

 
Figure 3-159 Classification under folding Line 

3. Inter-fold classification 

The operation procedure is the same as that of <Categorize on Folding Line>, and the upper and 

lower tolerance of the folding box should be set in the category setting window, and the wider the 

tolerance is, the wider the folding box will be drawn.  

In the point cloud located between two fold lines, all the point clouds belonging to the initial 

category will be set as the target category (Figure 3-161). 
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Figure 3-160 Inter-fold classification settings 

 
Figure 3-161 Inter-fold classification 

4.Polygon classification 

The operation steps are the same as <Categorize on Folding Lines >. The category of all the point 

clouds located inside the fold box that belong to the initial category will be set to the target category 

(Figure 3-162). 

 
Figure 3-162 Polygon classification 

5.Classification of brushes 

(1) Click menu <Profile> → < Classification of Brush >, in the pop-up dialog box, in addition to 

setting the initial category and target category, you also need to set the brush radius (Figure 

3-163). 
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Figure 3-163 Brush Classification Settings 

(2) Close the Brush Classification dialog box, press the left mouse button anywhere in the profile 

view, then the mouse cursor will be changed to a circle consistent with the brush radius (Figure 

3-164), press and hold the left mouse button, move the mouse and then lift the left mouse 

button. 

(3) At this time, the cursor circle swept through the point cloud data, all the initial category of 

point clouds belonging to the category of the target category will be set. 

 
Figure 3-164 Classification of Brush 

6. Single Point Classification 

(1) Click the menu <Profile>→<Single Point Classification>, after selecting any point in the profile 

view, the selected point will be marked by the red crosshair cursor, and the Single Point 

Classification dialog box will be popped up (Figure 3-165).  

(2) In the dialog box, you can modify the attributes of the point, including coordinates, color, 

intensity value, category and GPS time. After clicking the <Modify> button, the modified effect 

will be updated in the view immediately. 

 
Figure 3-165 Single Point Classification 
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7. Undo Editing 

Categories that have been manually categorized and not saved can be undone by clicking the undo 

button. 

8. Save 

Click the menu <Profile>→<Save >, and click <Yes> in the pop-up dialog box to save the point 

cloud data after processing the functions in the Profile menu. 

9. Abort 

Click menu <Profile>→< Abort > to exit profile editing and hide the profile editing menu. 

3.9 Toolbox 

3.9.1 Data Processing 

1. Extract 

The Extract tool allows you to filter the data and generate a new data file based on a number of 

conditions.  

(1) Extract Category  

The extract category tool can extract all the point clouds of the category according to the category 

selected for extraction by the user, and check the merge export to save the data in one file. Multiple 

point cloud files can be selected for operation. 

⚫ Click <Toolbox>→<Data Process>→<Extract>→< Class Export >, and a dialog box will pop 

up (Figure 3-166). 

⚫ The point cloud files are listed in the list of point cloud files loaded in the current software, 

check the point cloud files that need to be extracted by category, support to add point cloud 

files, remove point cloud files; check Merge Export to merge the extracted point clouds into a 

single file for exporting; select the point cloud files to export, support to select multiple 

categories; select multiple categories. 

⚫ Check Merge Export to save the data in one file. Select the category to be exported, support 

selecting multiple categories; select the required output format (hlz, las, xyz). 

⚫ The output path is stored in the POO path by default, support modifying it to a customized 

path, click <OK> to start the category extraction, and there will be a reminder message in the 

information output after the extraction is completed. 
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Figure 3-166 Category Extraction 

(2) Extract Echo  

The echo extraction tool can extract all the point cloud data of the echo to be saved in a file 

according to the type of echo selected by the user. 

⚫ Click <Toolbox>→<Data Process>→<Extract>→< Echo Export>, a dialog box will pop up 

(Figure 3-167).  

⚫ The point cloud files are listed in the list of point cloud files loaded in the current software, 

check the point cloud files that need to be extracted for echo extraction, and it supports to 

add and remove point cloud files.  

⚫ Check Merge and Export to merge the extracted point clouds into a single file for exporting. 

⚫ Select the point cloud types to be exported, and it supports to select multiple categories. 

⚫ Select the desired output format (hlz, hlz, hlz); and it supports to select the desired output 

format (hlz, hlz).  

⚫ Select the type of echo to be exported, support to select multiple categories. 

⚫ Select the required output format (hlz, las, xyz); the output path is stored in the POO path by 

default, support to modify the output path to a customized path. 

⚫ Click <OK> to start the echo extraction, there will be a reminder message in the information 

output after the extraction is completed. 

 
Figure 2-167 Echo Extraction 
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(3) Elevation Export 

The Elevation Export tool can extract all the point cloud data within the range according to the 

elevation range input by the user and save them to a file. 

⚫ Click <Toolbox>→<Data Process>→<Extract>→< Elevation Export>, a dialog box will pop 

up (Figure 3-168).  

⚫ List the point cloud files in the list of point cloud files loaded by the software, check the point 

cloud files that need to extract the elevation, support adding and deleting point cloud files; 

⚫ Check Merge and Export to merge the extracted point clouds into a single file for export;  

⚫ Input the range of elevation values to be exported;  

⚫ Select the desired output format (hlz, las, las);  

⚫ select the output format (hlz, las, las, las) to save the Save the data as a file.  

⚫ Input the range of elevation values to be exported;  

⚫ select the desired output format (hlz, las, xyz);  

⚫ The output path is stored in the POO path by default, and it supports to modify it to a 

customized path. 

⚫ Click <OK> to start the elevation extraction, and there will be a reminder message in the 

output of the information after the extraction is completed. 

 
Figure 3-168 Elevation Extraction 

2. Process 

(1) Remove the edge points of the air strip 

⚫ Click <Toolbox> → <Data Process> → <Process> → < Remove Strip Edge Points > on the 

main interface, a dialog box will pop up (Figure 3-169). 

⚫ The point cloud files loaded in the software are listed in the Point Cloud File List, check the 

files that need to remove the tape edge points, and then click <Start Execution>.   

⚫ After the culling is finished, a popup will appear, "Do you want to load the culled point cloud", 

click "Yes", and the culled point cloud will be loaded into the view. 
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If hlz data is processed, the point cloud generated after processing is hlz version 3.4. 

 
Figure 3-169 Remove the edge points of the air strip 

(2) Remove redundant data 

⚫ Click <Toolbox> → <Data Process> → <Process> → < Remova redundancy data> on the main 

interface, and a dialog box will pop up (Figure 3-170).  

⚫ Select the original photo POS file, store the original photo POS directory;  

⚫ Set the point threshold and angle threshold; click <Crop Preview> to check the effect of the 

POS crop, and then click <Data Removal> to remove invalid data in the POS of the photo.  

⚫ If the cropping is wrong, click the <Data Reject> button to reject the invalid data in the POS, 

and at the same time, save the rejected invalid photos to a new folder under the Image folder.  

⚫ For the "Remove Invalid Photos and POS" tool, if the cropping is not as expected, you can 

adjust the Point Threshold and Angle Threshold parameters and preview again until it meets 

the expectation. 

 
Figure 3-170 Remove redundancy data 

 
Figure 3-171 Crop Preview 
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(3) Point Cloud Optimize 

⚫ Click <Toolbox> → <Data Process> → <Process> → <Point Cloud Optimize> on the main 

interface, and a dialog box will pop up (Figure 3-172). 

⚫ The point cloud file list lists the point cloud files loaded in the current software, check the files 

that need to be optimized for the point cloud, support to add point cloud files, remove point 

cloud files;  

⚫ Set the number of nearest neighbors, the default is 20, the default path is stored in the poo 

path, support to modify to a custom path, after the optimization is completed, click "Yes", the 

optimized point cloud will be loaded into the view.  

⚫ Click <Start Execution>, after the optimization is finished, a popup will appear, "Whether to 

load the optimized point cloud into the view", click ”Yes“ to load the optimized point cloud 

into the view. 

 
Figure 3-172 Point Cloud Optimize 

3. Tiling 

(1) Point Cloud Framing 

The main purpose of the point cloud binning is to bin the point cloud according to certain criteria, 

generate the binned vector information, and then extract each small piece of point cloud for individual 

operation by <Process> → <Select Tiling Blocks>.  

⚫ Click <Toolbox> → <Data Processing> → <Tiling> → <Point Cloud Framing>, the pop-up 

window will list the point cloud files loaded by the software (Figure 3-173). 

⚫ Check the files that need to be split. When more than one point cloud file is selected, the 

software will first merge multiple point clouds and then perform the splitting operation.  

⚫ After selecting the file, you need to choose the splitting method and set the splitting 

parameters. 

⚫ When setting the customized block size and the number of blocks, users can refer to the 

information in the window prompted by the size of the enclosing box to make reasonable 

settings.  

⚫ Click <OK> when the settings are completed, the software will generate the vector file after 
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the splitting and load it to the vector layer in the workspace and the view selected by the user 

in the splitting parameters. 

 
Figure 3-173 Point Cloud Framing 

3.9.2 Format Transform 

1. Point cloud format transform 

Point cloud format conversion tool provides conversion between point cloud and other file formats.  

⚫ Click <Toolbox> → <Format Transform> → <Point Cloud Format Transform> on the main 

interface, and a dialog box will pop up (Figure 3-174). 

⚫ The point cloud list lists the point cloud files loaded in the current software, check the files that 

need to be converted to other file formats. 

⚫ The <Merge Export> checkbox can be used to set whether or not to merge multiple input files 

for export, and the following can be used to select the format of the exported file, the format 

version, and the path of the exported file. 

⚫ Click the <Properties> button, a dialog box will pop up (Figure 3-175), you can select the 

properties of the exported file, and click <OK> to complete the export. 

 
Figure 3-174 Point cloud format transform 
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Figure 3-175 Point cloud format transform attributes 

2. Point Cloud to Image 

The Point Cloud to Image tool saves the point cloud in the view as a .png image.  

⚫ Click <Toolbox> → < Format Transform > → <Point Cloud to Image> on the main interface 

(Figure 3-176),   the dialog box of Select Save As Path, select the folder to save the image. 

⚫ Click <Select Folder>, and the message output prompts: "Point Cloud to Image Conversion 

Succeeded". 

 
Figure 3-176 Point Cloud to Image 

3. Transform Coordinate 

(1) Single point transform 

Support the conversion between the geodetic, local and spatial coordinates of the source 

ellipsoid and the geodetic, local and spatial coordinates of the target ellipsoid.  

⚫ Click <Toolbox>→<Format Transform >→<Transform Coordinate> on the main interface, a 

dialog box will pop up (Figure 3-177). 

⚫ Click [Single Point] to enter the single-point coordinate conversion interface;  

⚫ Click the [Coordinate System] button to enter the coordinate system setup interface and set 

the parameters of the coordinate system; 

⚫ Click [Confirmation] to return to the single-point coordinate conversion interface; support to 

set the source ellipsoid or target ellipsoid geodetic coordinate, local coordinate, spatial 
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coordinate and the target ellipsoid geodetic coordinate.  

⚫ After setting the coordinate system parameters, click [Cancel] to exit the coordinate system 

setting interface, the set coordinate system parameters will not take effect;  

⚫ Support manually inputting the coordinates of the target ellipsoid;  

⚫ Click [Reverse Calculation] to calculate the coordinates under the target ellipsoid;  

⚫ Click [Reverse Calculation] to calculate the coordinates under the source ellipsoid.  

⚫ The software can calculate the coordinates under the source ellipsoid. 

⚫ In the coordinate conversion, there will be some precision loss, and the value of coordinates 

will be changed when we keep on doing the forward and backward calculation. 

 
Figure 3-177 Transform Coordinate 

(2) Coordinate point file transformation 

Support the conversion between the geodetic, local and spatial coordinates of the source ellipsoid 

and the geodetic, local and spatial coordinates of the target ellipsoid with the imported coordinate 

point files and coordinate system parameters.  

⚫ Click <Toolbox>→<Format Transform>→<Transform Coordinate> on the main interface, and 

then click [Coordinate Point File] to enter the interface of coordinate point file conversion 

(Figure 3-178). 

⚫ Click [Coordinate System] button to enter the interface of coordinate system setting, and set 

the parameters of coordinate system. 

⚫ Click [Confirmation], the interface of coordinate system setting will be closed, and then return 

to the interface of [Conversion of Coordinate File]; it supports the selection of BLH XYZ or NEZ 

coordinate type. 
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⚫ Click [...] to enter the [Custom Format Settings] interface; support the selection of options to 

be imported in the optional field column, the options are determined by the coordinate type 

selected in the [Coordinate Point File Conversion] interface, and the options selected for 

import will be displayed in the order of the content column. 

⚫ Click [OK] to enter the [File Directory] interface, select the files to be imported, and then click 

[OK] to return to the [Coordinate Point File Conversion] interface.  

⚫ Click [OK] button to enter the [File Directory] interface, select the file to be imported, and then 

click [OK] button, the software reads the file content and returns to the [Coordinate Point File 

Conversion] interface and displays it in the file column.  

⚫ After selecting the BLH, XYZ or NEZ option in the conversion result column, click the [Calculate] 

button or the [Reverse Calculation] button, the software converts the list of results to display 

the results of the conversion, and the [Export] button displays the results of the conversion as 

available. 

⚫ Click the [Export] button to enter the [Customize Format] interface, the user in the optional 

fields in order to select the options need to export, click [OK] button, the software returns to 

the [coordinate point file conversion] interface and prompts the export success. 

⚫ The software returns to the [Coordinate Point File Conversion] interface and prompts for 

successful export. 

 

Figure 3-178 Coordinate point file conversion 

(3) Las point cloud file conversion 

Support to read the point data from the imported las file, convert the coordinates from source 

ellipsoid to target ellipsoid and then save the converted las point cloud data.  
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⚫ Click <Toolbox>→<Format Transform>→<Transform Coordinate> on the main interface, and 

then click [Las Point Cloud File] → [Coordinate System] button to enter the coordinate system 

setting interface, set the parameters of the coordinate system. 

⚫ After setting the parameters of the coordinate system, click [Confirmation], and the parameters 

of the coordinate system will be used for returning to the las point cloud file conversion 

interface;  

⚫ Click [Add] to bring up the file selection pop-up; and then save the converted las point cloud 

data.  

⚫ Click [Add] to bring up the file selector, select the corresponding las point cloud file, click [OK] 

to load the point cloud file to the point cloud list; 

⚫ Manually input or click [Select] to select the storage path of the converted las point cloud file 

in the file directory selector; click [OK], the software will save the converted las point cloud file 

under the output path;  

⚫ Click [Cancel], the selected point cloud file will not be loaded to the point cloud list;  

⚫ Click [Remove], the added point cloud file will be removed;  

The coordinates in the converted las point cloud files are the source ellipsoid coordinates by default, 

and the coordinates in the converted las files are the target ellipsoid coordinates.  

The coordinate system corresponding to the coordinates in the added point cloud file must be 

consistent with the set coordinate system parameters, otherwise the las file saved after conversion will 

be converted abnormally, which will lead to abnormal file contents and cannot be opened successfully. 

 

Figure 3-179 Transform Coordinate 
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3.10 Engineering Application 

<Engineering Application> menu for section generation, by import the reference center line or 
view drawing reference center line, generate reference cross section, measured cross section, measured 
longitudinal section, and support, the measured longitudinal, transverse section editing, export, 
generate section, support section method for earthwork calculation, support multiple section contrast. 

 
Figure 3-180 Engineering Application 

3.10.1 One-Click Processing 

One-Click Processing is used for the export of terrain results, according to the imported point cloud, 
you can export the terrain results with one click, and support Ground Point classification, Contour Lines 
generation, DEM generation, Elevation Points generation, and support according to Terrain and Actual 
Result Requirements to perform advanced settings for the generated Terrain Results. 

3.10.2 Reference Centerline 

Reference center line provides two ways to generate: support view drawing reference center line 
and support importing reference center line 

3.10.2.1. View drawing 

After clicking [View Drawing], the mouse switches to the drawing vector state, selects the drawn 
position through the left click, confirms the drawn vector through the right click, and the view displays 
the vector file, and displays the drawn reference line in the lower left tree node. 

 
Figure 3-181 views are drawn 

3.10.2.2. Import 

Click on Reference Centerline ->Import to select Import Centerline, Cross Section Line, or Auto 
(Vertical, Cross Section). The selected vector file will be imported into the view and displayed in the 
lower left tree node. 
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3.10.3 Generate Reference Horizontal Section 

After drawing or importing the reference center line, the reference section can be generated 
through the center line, providing the setting parameters to automatically generate the reference 
section line, and generate the reference section line manually. 

(1) Automatically generate reference cross-section lines 

 
Figure 3-182 automatically generate reference cross sections 

Parameter setting: support setting the pile number spacing, left and right line length. Starting 
mileage setting: support the starting mileage to input the starting mileage value, support the custom 
coordinate input start and end XY value setting to generate the range of reference section, support the 
starting point of three ways to set the starting mileage. If you select a view, then click OK to select the 
point on the reference centerline with the left mouse button to determine the starting point for 
generating the reference section. 

(2) Manually generate reference cross-section lines 

 
Figure 3-183 manually generated reference cross-sections 

It is supported to set the left and right lengths. After selecting the reference section line manually, 
it is necessary to select the points on the reference centerline through the left mouse button to 
determine the location to generate the reference section. 
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Figure 3-184 automatically generates reference cross-section effects 

3.10.4 Generate Measured Vertical Section  

 
Figure 3-185 Generate Measured Vertical Section interface 

Support to set section width, simplify threshold, select point cloud category (default is ground point 
+ ground site) to generate the measured profile. 

(1) Simplified threshold: mainly function to ignore the profile points with the height difference of 
adjacent points less than this parameter. 

(2) Section width: generate the width value of the section. 

 
Figure 3-186 Generate Measured Vertical Section effect 

3.10.5 Generate Measured Horizontal Section  

1 Horizontal Section 
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Figure 3-187 Generate Measured Horizontal Section interface 

The measured cross section is generated in many ways: 
(1) By Reference Centerline-> Generate Measured Horizontal Section: can set the sampling step, 

section width, simplified threshold, pile spacing, left and right line length, provide starting range setting: 
support starting mileage input starting mileage value, support custom coordinates input start and end 
XY value set to generate reference section, support view specify the starting point of three ways to set 
the starting range 

(2) By Reference Centerline -> Generate Reference Horizontal Section -> Generate Measured 
Horizontal Section: sampling step length, section width and simplified threshold can be set. Other 
settings inherit the settings that generate the reference section. 

(3) By Reference Centerline -> Generate Measured Vertical Section -> Generate Measured 
Horizontal Section. 

 
Figure 3-188 Generate Measured Horizontal Section effect 

2. Tunnel Horizontal Section 



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  151  

 
Figure 3-189 Generate Actual Measured Tunnel Horizontal Section interface 

By setting the sampling step size, the section width and the simplified threshold, actual measured 
tunnel horizontal section can be generated and loaded into the view at the same time. 

3.10.6 Start Editing 

 
Figure 3-190 Start Editing interface 

Click the Start Editing button, and you can click the lower left tree node or the vector line to be 
edited on the view to edit the currently generated measured longitudinal and cross sections. The 
software view 1 highlights the node of the current longitudinal section line, automatically opens the 
section view, and displays the currently selected longitudinal section line and longitudinal section point 
cloud in the section view. Click the End Editing button to end the longitudinal section editing function 
and close the section view.  

The section view provides four editing functions: add node, delete node, move node, and delete 
nodes in batches. 

3.10.7 Export Sections 

Export the measured longitudinal and cross sections generated by the current data. 



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  152  

 
Figure 3-191 Export section interface 

When the user selects the mileage file dmx, hdm, NFhdm, the [Output mileage file format] can be 
set, but the [Merge] checkbox cannot be grayed out and cannot be set. .hdm and .NF-hdm output 
cross-section data. .dmx outputs longitudinal section data. 

When selecting dxf, dwg, shp, dat, csv, the [Merge] can be set, but the [Output mileage file format] 
is grayed out and cannot be set. 

3.10.8 Generate Section View 

 
Figure 3-192 Generate Section View interface 

The measured longitudinal and transverse sections will be generated for section map generation, 
and the position of the section can be displayed on the view and selected. The rows, column spacing 
and the number of columns generated by the section can be set. Support for the generation of section 
maps in both DXF and DWG formats. 
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Figure 3-193 Generate Section View effects 

3.10.9 Delete 

Click the delete button, click on the screen, and then select the vector entity to delete. Left key to 
select the middle vector line, right-click to confirm the deletion. 

Support the deletion of reference line, measured longitudinal section, reference cross section line 
and measured cross section line. If the reference line is deleted, the pop-up will indicate whether to 
delete the measured section line, measured section line and reference section line. If selected, delete; 
otherwise, do not delete. 

3.10.10 Section Method Earthwork Calculation 

According to the selected section, set the benchmark elevation generation section method 
earthwork calculation. 

 
Figure 3-194 Section Method Earthwork Calculation interface 
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3.10.11 Multi-Period section Comparison 

 
Figure 3-195 Multi-Period section Comparison interface 

Support the comparison of section data and output the comparison report, and support the 
comparison report export of the following situations: 

(1) Reference center line, comparison and export of measured longitudinal section lines of two sets 
of data. 

(2) Reference cross section line, comparison and export of measured cross section lines of two sets 
of data. 

(3) Uncheck reference center line, comparison and export of measured cross section lines of two 
sets of data. 

(4) Uncheck reference cross section line, comparison and export of measured longitudinal section 
lines of two sets of data. 
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3.10.12 Lower left section tree control 

 
Figure 3-196 Lower left section tree control interface 

In the engineering application, once the reference line, reference cross-section, measured 
longitudinal section, and measured cross-section are generated, they will be displayed in the section 
tree control in the lower left corner. The system supports operations such as clearing, deleting, and 
zooming on the nodes. It allows zooming to layers for both primary and secondary nodes, as well as 
clearing data. When "clear" is selected, the section data will be cleared. For tertiary nodes, it supports 
zooming to the layer and deletion. Once deleted, the corresponding entity will also be removed from 
the view. Additionally, it supports toggling the visibility of vector entities. 

3.10.13 Calculation of tunnel overshoot and undershoot 

<Calculation of tunnel overshoot and undershoot> mainly inputs and calculates the over-and-
under-excavation calculation section template. 

The user clicks [Engineering Applications] -> "Calculation of tunnel overshoot and undershoot", 
and the software pops up Calculation of tunnel overshoot and undershoot interface. The user clicks 
"Add" in the right-click menu of the section template list or "Add" at the bottom of the list, and then 
clicks "Add" in the right-click menu of the section template list or "Add" at the bottom of the list. The 
software pops up the section template input interface. The user enters the section template information 
and clicks "OK". The software exits the section template input interface, and a section template record 
is added to the section template list. 
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Figure 3-197 Calculation of tunnel overshoot and undershoot template editing interface 

Perform cross-section matching, select the mileage to be calculated, click calculate, and a tunnel 
over-excavation and under-excavation report in DXF format will be automatically generated. 

  
Figure 3-198 Tunnel over- and under-excavation interface 

3.10.14 Calculation of cross-sectional flow area 

<Calculation of cross-sectional flow area> is mainly based on a design height, which calculates the 
flow area of the generated measured longitudinal section. 

The user clicks on [Section Area Calculation] under [Engineering Applications] to display a dialog 
box for section area calculation. Enter the design height, enter the title, click OK, and generate a report 
for section area calculation. The report presents a comparison chart based on design height and 
longitudinal section, as well as a flow area table and flow area chart based on design height data. 
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Figure 3-199 Calculation interface for cross-sectional flow area interface 

 
Figure 3-200 Longitudinal section comparison diagram 
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Figure 3-201 Statistical Table of Overflow Area 

 
Figure 3-202 Statistical chart of overcurrent area 

3.10.15 Cross-section sedimentation analysis 

<Cross-section sedimentation analysis> is primarily based on a selected reference. It involves 
inputting two cross-section lines and two reference lines, where the intersection of these lines forms a 
calculation area. By setting the interval for analysis lines and sampling interval, a cross-section 
sedimentation analysis report can be generated. 

Click [Cross-section sedimentation analysis] under [Engineering Applications] to open the "Cross-
section sedimentation analysis" dialog box. Import the original point cloud data of two phases. Import 
two cross-section lines (in DXF format). These lines are opposite to each other and serve to enclose the 
sub-region for analysis, Import two reference lines (in DXF format). These reference lines intersect with 
each other and also intersect with the cross-section lines. In the displayed " Cross-section sedimentation 
analysis " dialog box: 

(1) Select the reference point cloud. 
(2) Import the two cross-section line files, which will be displayed in the 3D view. 
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(3)  Import the two reference line files, which will also be displayed in the 3D view. 
(4) Set the interval for analysis lines. The analysis lines start from Reference Line 1 and are spaced 

at the specified interval while extending toward Reference Line 2. 
Click [OK] to start calculations and export the analysis report. 

 
Figure 3-203 Cross-section sedimentation analysis interface 

3.11 Draw 

The <Draw> menu is used to add various point, line, and surface entities, and to perform operations 
such as deleting, line interruption, two-point interruption, connection, copying, extension, and 
smoothing on entities. When drawing entities, you can select the layer and coding attributes, and 
support viewing the attributes of various point, line, and surface entities. 

 
Figure 3-204 The vector-editing interface 
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3.11.1 View the properties 

 
Figure 3-205 View the attribute interface 

Click [View Properties] under [Draw], select a reference centerline, or measured longitudinal section 
line, or reference cross section line, or measured cross section line, and display the [Properties Panel] 
interface when [Properties Panel] is open in [Layout]. You can edit the color, layer, line type, and line 
width, but the length and area cannot be edited. 

3.11.2 Add Point 

Click [Draw] -> "Add Point" or the shortcut toolbar "Add Point", select the layer and code in the 
drop-down box, and left-click the position to add the point on the view. 

3.11.3 Add Line 

Click [Draw] -> "Add Line" or "Add Line" in the shortcut toolbar, select the layer and code in the 
drop-down box, click the nodes of the view to add lines in turn with the left mouse button, and right 
mouse button to end adding lines. 

3.11.4 Add Rectangle 

Click [Draw]-> "Add Rectangle" or "Add Rectangle" in the shortcut toolbar, select the layer and 
code in the drop-down box, left-click the view to add the starting point of the rectangle, move the 
mouse, then left-click the end point of the rectangle, and then then left-click the opposite corner of the 
rectangle to end adding the rectangle. 

3.11.5 Add Arbitrary Rectangle 

Click [Draw]-> "Add Arbitrary Rectangle " or "Add Arbitrary Rectangle " in the shortcut toolbar, 
select the layer and code in the drop-down box, left-click the view to add the starting point of the 
rectangle, move the mouse, then left-click the end point of the rectangle, and then left-click the 
opposite corner of the rectangle to end adding the rectangle. 
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3.11.6 Add Polygon 

Click [Draw]-> "Add Polygon" or "Add Polygon" in the shortcut toolbar, select the layer and code 
in the drop-down box, click the left mouse button on the drawing to add a polygon node, right click to 
end the drawing, and the polygon will automatically close at the beginning and end without filling, 
completing the drawing of a single polygon entity. 

3.11.7 Add Circle 

Click [Draw]-> "Add Circle" or "Add Circle" in the shortcut toolbar, select the layer and code in 
the drop-down box, and then click the left mouse button on the drawing to add a circular node. Select 
the node as the position on the arc, add three nodes to judge and end the drawing command. The 
triangle formed by the three selected points must be an acute triangle. After judging that the inscribed 
triangle of the circle meets the requirements, submit the drawn circle and save it to the corresponding 
vector file. 

3.11.8 Delete 

Click [Draw]-> "delete", and then choose to delete the entity, When selecting, you can select the 
entity by the left mouse click or box selection,, if the choice is wrong, or more, or choose less, can hold 
the ctrl key to select point or box for increasing or reducing the selection. After the selection is 
completed, right-click to complete the delete operation. 

3.11.9 Line Break 

Click [Draw]-> "Line Break" or "Line Break" in the shortcut toolbar, to select the line by the left 
mouse click or box selection select single or multiple closed line (surface) entities, break the intersecting 
line entities, and remove the part within the closed surface to obtain the new line segment and the 
original line segment after truncation. 

3.11.10 Two-Point interruption 

Click [Draw]-> "Two-Point interruption" or "Two-Point interruption" in the shortcut toolbar, select 
the nearest line entity within the threshold range by clicking the left mouse button, and directly specify 
the first point on the line according to the selected position, click the left mouse button to select the 
second point on the line, break the line into three segments according to the two points, remove the 
middle part between the two points, and keep the remaining two parts to obtain the newly added line 
object and the original entity after truncation, and submit the modification to the vector data. 

3.11.11 Connect 

Click [Draw] -> "Connect" or shortcut bar "Connect", left click select one end of the line, left click 
select one end of the other line, to connect. 
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3.11.12 Copy 

Click [Draw] -> "Copy" or shortcut bar "copy", left click to select the entity to copy, move the 
mouse, and then click the left button to copy. 

3.11.13 Extend 

Click [Draw] -> "Extend" or shortcut bar "Extend". On the drawing, left-click the mouse to select 
the line entity to be extended, and determine the distance from the first and last breakpoints of the line 
according to the selected position. Use the near end as the starting point for extension. On the drawing, 
left-click the mouse to select another line entity as the target entity to be extended to. Extend according 
to the selected endpoint and the direction of the previous point (the previous node and breakpoint are 
taken to form the tangent direction after the curve or arc is broken into a line) of the line entity to be 
extended, and obtain the intersection with the target line entity. Add the intersection position to the 
line entity to be extended as the new endpoint position, and submit the line entity after extension to 
the vector data. 

3.11.14 Smooth 

Click [Draw]-> "Smooth" or "Smooth" on the shortcut toolbar, you can select the line entities that 
need to be smoothed by the left mouse click or box selection. If you make a wrong selection, or select 
too many or too few, you can hold down the ctrl key to click or box select to increase or decrease the 
selection. After the selection is complete, right-click to complete the smoothing operation. 

3.11.15 Add Arc 

Click [Draw]-> "Add Arc" or "Add Arc" on the shortcut toolbar, select the layer and code in the 
drop-down box, and then click the left mouse button on the drawing to add an arc node. After adding 
the three nodes, judge and end the single arc drawing. Draw the arc composed of three points through 
the selected three points, and write the selected layer and Cass code into the new entity. 

3.12 Architectural 

The <Architectural > menu is used to slice point clouds, draw slices, and export drawing data. 

3.12.1 Point Cloud Slice 

Click [Architectural]->"Point Cloud Slice" button to automatically display the section view and pop 
up the point cloud slice property page. The properties display the following contents: show/hide slice 
arrow button, reference plane (including X-axis, Y-axis, Z-axis, any three points), point selection interface 
including XYZ value and point selection button, drawing button, close button. The coordinates of the 
point selection interface default to the average value of point cloud XYZ, supporting three points to 
determine the reference plane, and two methods of determining the plane by X-axis, Y-axis, and Z-axis. 
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After determining the plane, you can select points on the view by selecting points, or select points 
by manually entering point coordinates in the display box. After entering the value, press Enter to 
modify the parameters and take effect. 

At the same time, you can customize the thickness value of the slice, which will take effect as soon 
as it is entered, and the input thickness value will be displayed in the section view and drawing window. 

Click Draw to jump to the drawing interface and perform drawing operations on the current slice. 

 
Figure 3-206 Point cloud slices interface 

3.12.2 Export 

Click [Architectural]->"Export" button to jump to the export interface, and export the currently 
drawn vector file. It supports merged export, and the output format runs DXF and DWG. The export 
options support 3D and 2D. It also supports exporting the drawn slices in the specified las format. 
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Figure 3-207 Export interface 

3.13 SLAM 

3.13.1 SLAM Processing 

SLAM point cloud processing can calculate the POS trajectory and point cloud from the collected 
SLAM data. After creating a new project or opening a project, click <SLAM> → < SLAM Processing > 
on the main interface menu to pop up the point cloud solution dialog box, in which the project name 
and task name under the project folder are automatically read. If different tasks have different 
acquisition modes or need to be solved by different solution methods, users can select project/task 
settings respectively. In addition, you can check the functions of point cloud coloring, moving object 
removal, point cloud denoising and point cloud smoothing as required. After checking, you can 
synchronize processing during point cloud processing. When there is a separate acquisition control 
point in the acquisition process, you can check <Control Point> and click <Edit> → <Import Control 
Point> → check whether to enable, so as to improve the accuracy of point cloud processing by matching 
the coordinates of control points.  

When selecting PPK solution, you can choose the source of the base station, which defaults to built-
in RTCM. When selecting a GNSS file, you need to locate the file path and enter the base station 
coordinates and antenna parameters. Alternatively, you can select from favorites. See 3.3.1.1 for details. 
After setting is complete, click OK. 

 The selectable point cloud formats for outputting point clouds include HLZ and LAS. The format 
version can be selected from the dropdown menu. 
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The coordinate system settings, as described in 3.3.1.3, encompass projection, datum, ellipsoid 
transformation, plane transformation, elevation fitting, grid correction, translation parameters, options, 
parameter calculation, import, and coordinate system management. If you check apply to all projects, 
the coordinate transformation parameters of the current project will be applied to all other projects. If 
you do not need to apply them to other projects, do not check this option. 

If you need to solve all projects, check solve all projects. If not checked, it will solve the current 
project. After setting, click start solving. 

 

Figure 3-208 SLAM Processing interface 
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      Figure 3-209 Select base station file interface 

 

Figure 3-210 Import Control Point interface 

3.13.2 Sampling Points Align 

SLAM control point concatenation is mainly used to concatenate point cloud data from different 
collection tasks through the collection point pairs during the job. Click on the menu<SLAM>→
<Sampling Points Align>on the main interface to bring up the Sampling Points Align dialog box. 
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Figure 3-211 Sampling Points Align interface 

3.13.3 Coloring 

SLAM point cloud coloring can be performed after selecting the model file. Click on the 
menu<SLAM>→<Coloring>on the main interface, and a point cloud coloring dialog box will pop up. 
Select the point cloud path and model folder path, check the point cloud that needs to be colored, 
and click OK to color it. 

 

Figure 3-212 Import Control Point interface 

3.13.4 Point Cloud Denoising 

SLAM point cloud denoising mainly involves denoising and smoothing point cloud data. Click on 
the<SLAM>->< Denoising>menu on the main interface to bring up the Point Cloud Denoising dialog 
box. By default, the dialog box will select Point Cloud Denoising and Point Cloud Smoothing, and list 
the currently loaded point cloud files in the software. You can also select the point cloud files that need 
to be processed. If point cloud smoothing is not required, you can uncheck them. 
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Figure 3-213 Point Cloud Denoising 

3.13.5 Manual denoising 

SLAM manual denoising mainly involves denoising and classifying post-processing point cloud data. 
Click on the menu<SLAM>→<Manual denoising>on the main interface, and a point cloud denoising 
dialog box will pop up. Select the initial category and target category in the pop-up window, and select 
the target point cloud in the box. If the box selection is incorrect, click undo. After confirming that the 
box selection is correct, save and exit. 

3.13.6 Collection Point 

SLAM collection mainly exports the point coordinates collected in SLAM mode during the job 
process. Click on the<SLAM>-><Collection Point>menu on the main interface, and a collection point 
dialog box will pop up. Select the project name and task name, and the collection point information will 
be automatically read. Confirm the export type (export the collection point of the current task or the 
collection points of all tasks under this project), and then click Export to bring up the collection point 
export dialog box. 

File: You can specify the export file name and select the export file format, .txt, .csv. 
Location: Specify the export file location. 
Custom format settings: When there is no template, the exported content and field order can be 

specified. If selected on the left and added to the right, it will be considered as the specified field; You 
can choose to export in the order of collection or in the order of point numbers in the export order; 
Floating point precision can specify the number of decimal places in a numerical value; The delimiter 
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can specify the delimiter symbol between fields; If the format file header is checked, the exported file 
will contain data headers. 

Template management: Templates can be fixed and exported through customization. 

 
Figure 3-214 Export of collection points 

3.13.7 Point Cloud Export 

On the main interface, click on the menu <SLAM> ->< Export> to bring up a dialog box. Users can 
select the desired export options, surface category, output format, and point cloud attributes for 
customized export. 

Export options: <Filter> supports setting parameters to dilute and export point clouds; <Class> 
supports selecting a specific category for export, with multiple options available. The default category 
is all categories; <Regular Export> means complete export; <Subsection> means that each original 
scanned file is exported to multiple target point cloud files in segments based on GNSS time; 'Split 
export' means that each original scanned file is exported to multiple point cloud files based on the 
polygons in the polygon file, and the polygons involved in the export can be set through field values; 
<Volume Export> means that point cloud data is divided into files according to the set size for output 
(this setting is only valid for las format point clouds). 

The output formats include: hlz, las, laz, pts, xyz, pcd, and e57, with multiple export formats 
available. Click the export button to export the selected point cloud. 
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Figure 3-215 Point Cloud Export 

3.13.8 Related Control Points 

Click on the menu <SLAM> ->< Related Control Points > on the main interface to support 
associating control points in txt and csv formats. After selecting the control point file, click OK to open 
the ASCII file window. 

When the control point file has a title or header, it is necessary to set the first few lines of the control 
point to be ignored; Then correspond the coordinate orientation of each column of data for the control 
point, set it up, click apply, and display the control point in the current point cloud. 
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Figure 3-216 Related Control Points 

 

 

Notes: 1. Ignoring the header of the control point may result in the failure of 
importing the control point;  

2. Incorrect correspondence of control point coordinates to xyz can result in the 
control point not being together with the point cloud.  

 

3.13.9 Accuracy Inspection 

After loading the point cloud and associating it with control points, enter <SLAM> → < Accuracy 
Inspection > to enter the Accuracy Inspection dialog box. Accuracy Inspection provides two methods 
for point selection: manual point selection and automatic search. The accuracy verification function is 
not bound to the project and can be imported separately into las or hlz to support verification. 
1.Manual point selection 

By selecting scanning points to perform accuracy verification with control points, the results of 
accuracy verification can be obtained. 

 Click on precision check, and the page will bring up a magnifying glass view for point selection. 
Select the matching scanning point at the corresponding position of each control point, left click to 
confirm the point selection. After the scanning point selection is successful, the corresponding scanning 
point will be filled to the right of the control point list. If you are not satisfied with the selected point, 
you can reposition it to the corresponding scanning point position and select the scanning point again, 
or manually modify the scanning point coordinates and press Enter to confirm. At this point, complete 
the selection of all scanning points, click to display the results, and the system will automatically 
calculate the accuracy of the current data based on the correspondence between the control points 
and the scanning points. At this point, clicking on export report will redirect you to the report save 
interface. 
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2.Automatic search 
When clicking on automatic search, the program first searches for target points near the control 

point. Currently, it only supports square checkerboard grids with a size of 50cm * 50cm targets. If it 
cannot be found, then a point cloud of 1m * 1m in size is found within a 1m range above and below the 
control point. After finding it, a weighted coordinate is calculated based on the zy distance from the 
point to the control point. If normal is selected, the scanning point xyz will not be grayed out. If it is an 
elevation, the scanning point xy will be grayed out. If it is a plane, the scanning point z will be grayed 
out. 

The formula for calculating the mean square error  in the X direction is: 

 
The formula for calculating the mean square error  in the Y direction is: 

 
The formula for calculating the mean square error  in the Z direction is: 

 

The calculation formula for the error X in the plane is: 

 
In the formula, ,  and  respectively represent the coordinate error values between the 

scanning point and the control point in the X, Y, and Z directions. 
Surface category selection: After selecting a category, only the points corresponding to the 

category will be searched during automatic search. The category can be selected from a certain 
category or all categories, and the category defaults to all category points; Manual point selection in 
the view is not limited by the category set; The magnifying glass view displays the specified category 
point cloud. 
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Figure 3-217 Accuracy Inspection main 

 
Figure 3-218 Automatic Search 
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Figure 3-219 Precision Check 

 

 
Figure 3-220 Export Report 
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Figure 3-221 Category Selection 

Control point types: including regular, planar, and elevation control points. Horizontal control 
points are only valid for X and Y coordinates, while elevation control points are only valid for Z 
coordinates. 

There are five point selection methods: ordinary point selection, fitting intersection points, fitting 
center points, fitting circular targets, and fitting checkerboard targets. Ordinary point selection can be 
directly left clicked on the magnifying glass view for point selection; The fitting intersection point is 
determined by identifying the intersection point of two lines to select a point; Fitting the center of a 
circle refers to selecting two points on the magnifying glass view to determine the diameter of the circle, 
and moving the mouse to determine the shape of the circle. At this point, the center of the circle is the 
determined point. Fitting a circular target is automatically fitting the center of the target based on the 
selected point cloud. Fitting a checkerboard target is selecting the middle point position of the 
checkerboard points. 
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Figure 3-222 Line Verge 

 
Figure 3-223 Draw Circle 
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Figure 3-224 Circle Board Center 

 
Figure 3-225 Chessboard Center 

 

3.13.10 Earthwork Calculations 

After loading the point cloud, enter <SLAM> → <Earthwork Calculations> to enter the Earthwork 
Calculations dialog box. Earthwork calculation mainly includes single phase earthwork calculation and 
multi phase earthwork comparison. The calculation format supports HLZ, LAS, Tif, and allows for the 
selection of basic elevation, setting range calculation, and more. 

3.13.10.1 Single-Period Calculation 

Single-Period Calculation requires selecting a point cloud file that supports (HLZ, LAS, TIF) formats. 
The dropdown menu allows you to select the file to import the view, while the 'Select' option on the 
right allows you to export a point cloud file from your local computer. 
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The benchmark elevation can be set through the right side bounding box, including minimum value, 
maximum value, average value, self selected point, and customization. Among them, the self selected 
point can be directly clicked from the view to obtain a benchmark elevation point; Customization can 
manually fill in an elevation value as the reference elevation. 

The algorithm has options of Triangulation and Latticework, with Triangulation being the default. 
The grid size can be set by default (0.2m), which determines the density of thinning. The larger this 
value, the sparser the point cloud, the lower the calculation accuracy, and the faster the speed. When 
calculating large point cloud data, the parameter size can be appropriately increased to achieve faster 
calculation speed. 

The point cloud category can be selected either from the dropdown menu or by specifying the 
category via the [Select] button on the right for calculation purposes. 

The prescribed range can be left unspecified or specified. The specified method is to read range 
points from files in formats such as .shp, .dxf, .txt, .csv, or to select ranges from views. Clicking on 
'Calculate' and waiting will bring up the calculation results. After the calculation is completed, the results 
can be exported in PDF, HTML, and DOC formats. 

 
Figure 3-226 Single-period volume calculation 



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  179  

 
Figure 3-227 Earthwork calculation results 

3.13.10.2 Multi-Phase Comparison 

Multi-phase earthwork comparison is shown in the figure. Multi-phase earthwork comparison 
should include at least two phases of data for calculation. The "+" on the right side of the list can add 
point clouds to the list. By default, the data behind the list refers to the data in the previous list, and 
their reference logic can be adjusted by using the up and down arrows. The "-" can remove the selected 
data. The algorithm settings are the same as those for single period data, and the grid size is set to the 
size of thinning, with a default value of 0.2m. The specified range is also consistent with single period 
calculations. Clicking on 'Calculate' and waiting will bring up the calculation results. After calculation, 
the calculation results can be exported in formats such as PDF, HTML, CSV, XLS, and TXT. 
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Figure 3-228 Multi-phase earthwork comparison 

 
 

3.14 3DGS 

3DGS modeling requires special attention to minimum computer configuration requirements: an 
NVIDIA graphics card (20, 30, or 40 series) with at least 8GB of VRAM and at least 32GB of 
RAM.Assuming the host hardware meets these minimum requirements, install the 3DGS module, open 
the SLAM project data, select the SLAM task, and on the main interface, click the menu <3D Gaussian 
modeling > → <Modeling>. In the pop-up dialog box, select the scene type "Large Scene" or "Small 
Scene," and click <Generate Model> to begin 3DGS modeling.Note: When using this module, after 
installing the Hi-Lidar version, the Gaussian modeling module must also be installed, and the person 
registering must authorize the Gaussian modeling module during registration. 

 

Figure 3-229 3D Gaussian Modeling Menu 
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Figure 3-230 3D Gaussian Modeling - Scene Type Selection 

After completing the 3D Gaussian model, click the menu <3D Gaussian Modeling> → <Browse> 

to enter the 3D Gaussian browsing interface, which supports browsing, rotating, scaling, and translating 

the 3D Gaussian model. 

 
Figure 3-231 3D Gaussian Browser Interface 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



                   Sat-LiDAR User Manual 
 

www.satlabgeo.com  182  

 
 
 
 
 
 
 
 
 
 

  Headquarter: 
Stora Å vägen 21,  
436 34 ASKIM, Sweden 

   info@satlabgeo.com 
 

  Regional Offices: 
  Warsaw, Poland 
  Jičín, Czech Republic 
  Ankara, Turkey 
  Scottsdale, USA 
  Singapore 
  Hong Kong 
  Dubai, UAE 

  
  www.satlabgeo.com 

 
 


	Software Introduction
	1.1 Software Overview
	1.2 Technical Parameters
	1.3 Installation and Uninstallation
	1.3.1 Software Installation
	1.3.2 Uninstalling the software
	1.3.3 Software Startup


	Sat-LiDAR Quick Instruction
	2.1 Software Interface
	2.1.1 Welcome Interface
	2.1.2 Main Interface
	2.1.3 Interface elements
	2.1.3.1 File
	2.1.3.2 View
	2.1.3.3 Aircraft
	2.1.3.4 Tool
	2.1.3.5 Process
	2.1.3.6 Terrain
	2.1.3.7 Layout
	2.1.3.8 Engineering Applications
	2.1.3.9 Draw
	2.1.3.10 Common toolbar
	2.1.3.11 Workspace
	2.1.3.12 Data View
	2.1.3.13 Toolbox
	2.1.3.14 Information Output
	2.1.3.15 Status Bar


	2.2 Standard Operation Procedure
	2.2.1 New project
	2.2.2 Original data Check
	2.2.3 Strip edit
	2.2.4 Flight route inspection
	2.2.5 Project and point cloud combine setting
	2.2.6 Data combine and optimization
	2.2.7 Point cloud quality check
	2.2.7.1 Strip overlap check
	2.2.7.2 Height difference Quality Check
	2.2.7.3 Density Quality Check:
	2.2.7.4 Coverage inspection

	2.2.8 Section view check stratification
	2.2.9 Trajectory Rectify
	2.2.10 Precision check
	2.2.11 Point cloud coloring
	2.2.12 Point Cloud Processing
	2.2.12.1 Point Cloud tiling
	2.2.12.2 Point cloud Classify

	2.2.10 Generate terrain products


	Description of the main functions
	3.1 Files
	3.1.1 New Project
	3.1.2 Open Project
	3.1.3 Close Project
	3.1.4 Save Project
	3.1.5 Open Files
	3.1.6 Opening Workspace
	3.1.7 Save Workspace
	3.1.8 Save Workspace As
	3.1.9 Close
	3.1.10 System Settings
	3.1.11 About
	3.1.12 Exit

	3.2 View
	3.2.1 View Browsing
	3.2.2 Rendering
	3.2.3 Other

	3.3 Aircraft
	3.3.1 Auto Process
	3.3.2 Trajectory Solving
	3.3.3 Combine Setting
	3.3.4 Begin Combine
	3.3.5 Stop Combine
	3.3.6 Strip Rectify
	3.3.7 Point Cloud Smoothing
	3.3.8 Point Cloud Colorize
	3.3.9 Point Cloud Export
	3.3.10 Related Control Points
	3.3.11 Accuracy Inspection
	3.3.12 Point Moving
	3.3.13 Original Data Check
	3.3.14 Flight Route Quality Check
	3.3.15 Strip Overlap Analysis
	3.3.16 Height Different Quality Check
	3.3.17 Density Quality Check
	3.3.18 Coverage Quality Check
	3.3.19 Automatic Quality Check
	3.3.20 Point Cloud Processing
	3.3.21 Generate DOM

	3.4 Tools
	3.4.1 Measurement tools
	3.4.2 Selection tools
	3.4.3 Point selection tools
	3.4.4 Other tools

	3.5 Process
	3.5.1 Section View
	3.5.2 Point Cloud Tiling
	3.5.3 Select Tiling Block
	3.5.4 Automatic Classification
	3.5.5 Reset Classify
	3.5.6 Noise Filter
	3.5.7 Classify Ground
	3.5.8 Median Ground Point
	3.5.9 Reset Classify Parameters
	3.5.10 Partial Classification
	3.5.11 Execute
	3.5.12 Saving Classification Parameter
	3.5.13 Manage Classification Template
	3.5.14 Manual Registration

	3.6 Terrain
	3.6.1 Generate DEM
	3.6.2 Generate DSM
	3.6.3 Generate contour lines
	3.6.4 Generate Elevation Points
	3.6.6 Earthwork Calculations

	3.7 Layout
	3.7.1 Layer Management
	3.7.2 Properties Panel
	3.7.3 Toolbox
	3.7.4 Information Output
	3.7.5 Welcome Interface

	3.8 Profile Selection
	3.8.1 Section Display
	3.8.2 Moving the profile down
	3.8.3 Move Profile Up
	3.8.4 Move Profile
	3.8.5 Rotate Profile
	3.8.6 Extend profile
	3.8.7 TIN
	3.8.8 Hide TIN
	3.8.9 TIN Modes
	3.8.10 TIN Rendering
	3.8.11 Light-off
	3.8.12 Manual Classification

	3.9 Toolbox
	3.9.1 Data Processing
	3.9.2 Format Transform

	3.10 Engineering Application
	3.10.1 One-Click Processing
	3.10.2 Reference Centerline
	3.10.2.1. View drawing
	3.10.2.2. Import

	3.10.3 Generate Reference Horizontal Section
	3.10.4 Generate Measured Vertical Section
	3.10.5 Generate Measured Horizontal Section
	3.10.6 Start Editing
	3.10.7 Export Sections
	3.10.8 Generate Section View
	3.10.9 Delete
	3.10.10 Section Method Earthwork Calculation
	3.10.11 Multi-Period section Comparison
	3.10.12 Lower left section tree control
	3.10.13 Calculation of tunnel overshoot and undershoot
	3.10.14 Calculation of cross-sectional flow area
	3.10.15 Cross-section sedimentation analysis

	3.11 Draw
	3.11.1 View the properties
	3.11.2 Add Point
	3.11.3 Add Line
	3.11.4 Add Rectangle
	3.11.5 Add Arbitrary Rectangle
	3.11.6 Add Polygon
	3.11.7 Add Circle
	3.11.8 Delete
	3.11.9 Line Break
	3.11.10 Two-Point interruption
	3.11.11 Connect
	3.11.12 Copy
	3.11.13 Extend
	3.11.14 Smooth
	3.11.15 Add Arc

	3.12 Architectural
	3.12.1 Point Cloud Slice
	3.12.2 Export

	3.13 SLAM
	3.13.1 SLAM Processing
	3.13.2 Sampling Points Align
	3.13.3 Coloring
	3.13.4 Point Cloud Denoising
	3.13.5 Manual denoising
	3.13.6 Collection Point
	3.13.7 Point Cloud Export
	3.13.8 Related Control Points
	3.13.9 Accuracy Inspection
	3.13.10 Earthwork Calculations
	3.13.10.1 Single-Period Calculation
	3.13.10.2 Multi-Phase Comparison


	3.14 3DGS


